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1 Introduction 
 
Blue Sky Plan® is Windows computer software intended for 3D virtual surgical implant placement, 
giving clinicians a more accurate way to treat patients. Blue Sky Plan® is precise and can help the 
clinician determine the ideal position for implant placement for the best esthetic and functional results. 
Blue Sky Plan® can be used for diagnostic purposes and can aid in the fabrication of surgical guides 
for computer-guided surgery. Using Blue Sky Plan® is the way to give your patients the best care 
available. 
Blue Sky Plan converts a Computer Tomography (CT) or Cone Beam Computer Tomography scan into 
a format that allows the dentist to assess the anatomic topography of the maxilla and mandible as well 
as the location of important structures. The patient’s CT or CBCT images will be stored in DICOM 
format from an Imaging Center. The software converts these images and makes it possible to view the 
patient’s anatomic structures. These data can be used for accurate pre-surgical treatment planning. 

 
 
 

The dentist can use the program to: 
• carry out pre-surgical planning 
• help fabricate an accurate surgical guide 
• decrease the risks of surgical complications 
• create realistic simulations of the treatment plan 
• assist in selecting the type and size of implants 
• assess results of prior bone grafting procedures 
• store the patient data 
• allow visual communication with patients and the 
implant team 
• demonstrate knowledge, credibility, and safety 
• help provide advanced patient care 

 
 
Blue Sky Plan® software can be downloaded from http://www.blueskybio.com. A user license must be 
obtained for each installation. During the installation process the software will prompt the user to 
request a license via the internet. 

 
 
1.1 Indications For Use 

 
Blue Sky Plan is intended to be used as conversion software for Computed Tomography (CT) 
generated DICOM images into a format that allows a dentist to assess the anatomic topography of the 
maxilla and mandible as well as location of important structures. It allows the information to be used 
for pre-surgical treatment planning of dental implant procedures. 
Blue Sky Bio Aligners are a series of clear, lightweight, plastic appliances indicated for the treatment of 
tooth malocclusions in patients with permanent dentition (i.e., all second molars). Utilizing a series of 
incremental tooth movements, it sequentially positions teeth by way of continuous gentle force. 
Blue Sky Bio Computerized Bracket System is a software system intended for use as an aid in 
orthodontic treatment planning to correct Malocclusions in Orthodontic Patients. For use by dental 
professionals trained in orthodontic treatment, including radiographic analyses and treatment planning. 
Blue Sky Bio Computerized Orthodontic Bracket System is intended for use with commercially 

http://www.blueskybio.com/
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available brackets currently used in standard orthodontic treatment. The end product is an indirect 
bonding tray for use by the Dental professional to place multiple brackets at the same time. 
The denture module is intended to be used to design a denture and export the entire denture or 
selected parts of the denture from the software for 3D printing 
The crown and bridge functionality allows a dental professional to design one or more new teeth in the 
Blue Sky Plan that will attach to either a damaged tooth or a titanium based abutment. 

 
 
1.2 Warnings 

 
The software does not contain any functionality verifying if real-life implementation of the virtual 
treatment plan might result in damage to the patient. Any virtual treatment plan should be evaluated by 
a trained licensed professional confirming that the virtual treatment can be implemented in real life and 
will not cause harm to the patient. 
If the segmentation function of the software is used, the segmentation has to be carefully evaluated to 
ensure that it matches the patient's anatomy and corrected if necessary. 
It is important to verify that the imported and exported data sets are of adequate quality and match the 
patient's anatomical structures. 
Appliances manufactured based on the virtual treatment plan should be made only from biocompatible 
materials that have suitable mechanical properties and are in compliance with local regulatory bodies. 
Appliances should be marked with patient information to avoid errors when delivering the appliance. 
Poor quality radiographic or optical images, inadequate training of user or inadequate hardware can 
affect the image results. 
The DICOM data can be used to do the following: 
1) make a scale 3D model of the jaw with the planned implant according to the illustrations below: 
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2) fabricate a surgical guide supported on bone 
 

 

3) fabricate a surgical guide supported on the gingiva 
 

 
*The files with three-dimensional positioning of implants and the file of the three-dimensional guide 
can only be generated in Blue Sky Plan®. 

 

2 Installing Blue Sky Plan 
 
Blue Sky Plan® software supports Windows operating system. Installation packages are available for 
the systems indicated. 
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2.1 Installation process 
 
After downloading the Blue Sky Plan® software to your hard drive, simply execute the file and follow 
the steps to proceed: 

 
 
 
 
 
 
 

Choose the language and click “OK”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Carefully read the license agreement, select one 
of the options, and click "Next". 
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Click "Next". 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click "Next". 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click "Install". 
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2.2 Hardware requirements 

 
Minimum requirements: 

Click "Finish". 

• Processor: Quad Core Intel i7 or comparable 
• RAM: 16 GB 
• Video card: NVidia, AMD or Intel, 2 GB of video RAM, OpenGL 3.3 supported (e.g. 

NVidia GeForce GTX 1050, GeForce 940MX, AMD Radeon RX 530, Radeon R5 M420, Radeon 
Pro 450 or comparable) 

• Screen res.: at least 1440 X 900 
• Hard Disk: 5 GB of free space 

 

2.3 Operating system 
 
Minimum requirements: 

• Windows 10 Home/Professional 64 bit 



BS-LS-0161-en Rev 4 Blue Sky Plan® 11 2023-08  

3 Intro screen and selection of planning type 
 
Blue Sky Plan® allows many different types of planning. In addition to implant planning, it also allows 
the user to plan orthodontic treatments based on imported STL models of the jaw with teeth, create 
bridges and crowns, model and export dentures, and cephalometric analysis. Selecting a planning 
type and creating a new project is done using the intro screen, which appears after starting Blue Sky 
Plan as well as during the creation of a new project. 

 
 

In most planning cases, the Model Master module is the first one to be loaded. It’s used for preparing 
STL models before the planning process itself. The Model Master module allows the user to create 
models from CT surfaces, modify the orientation and positioning in the BSB coordinate system, but 
most importantly to modify the STL models – including cropping, polishing and surface modifications, 
closing and creating hollow models. Endodontic Planning allows the user to use a treatment sequence 
for the infected pulp of a tooth. The splint module is used to ease muscle tension and stabilize the jaw. 
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4 Loading the patient’s CT or CBCT scan 
into Blue Sky Plan 

 
Blue Sky Plan ® can load uncompressed DICOM images (exported by all CT scanners) into the 
software. Blue Sky Plan is “ self-processing ” allowing the user to directly import the DICOM images in 
a few easy steps. A complete scanning protocol is available via the Blue Sky Bio website and can be 
sent to the scan site. 

 
4.1 Selecting the DICOM images location 
To import the patient’s CT or CBCT images, follow these steps: 
1. Select planning type "Surgical guides" and then "Import Patient CT Scan". 
2. A new window will appear. 

 

Note that there are several shortcut buttons that appear on the top of the window. These buttons allow 
quick navigation to the folder containing the DICOM images. 
Select the directory that contains the DICOM images (you can also load zipped file with DICOM 
images) and click OK. Images must be stored in DICOM format from your Imaging Center in order to 
load them into Blue Sky Plan®. 
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4.2 Selecting the series 
 
A list of available series that can be loaded will appear (1). Ideally each series should be saved in a 
separate folder, and only one series will appear. 

 

 
 
 

4.3 Enhancing performance 
 
In the case that the computer does not have sufficient system or video memory, and possibly also if 
the video card is not sufficiently powerful, the program makes it possible to reduce (downsample) the 
input data; the user may set this manually for each axis or choose one of the available settings (2). 
The software will automatically compensate for the “skipped” slices, and the quality of the treatment 
plan and Surgical Template will not be compromised. 

 
4.4 Scan alignment and defining the range of slices 

 
In this step you align volumetric data and delimit the area of interest in the data. It is possible to crop 
the data in all directions by dragging the yellow lines (1) or by directly setting the dimension of the slice 
for the individual axes (2). The data display mode can be changed by selecting “Imaging Mode” (3). 
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The data can be aligned using the blue circles (4); it is also possible to enter values for rotation around 
the individual coordinate axes manually (5). The transformation performed then applies correctly for 
importing data. 
Given the significant memory and performance requirements for visualizing 3D medical data, it is 
advisable to crop the input data to the actual area of interest; this allows the program to run much 
more smoothly. 

 
 
4.5 Import additional surfaces 

 
After loading CT data, user can import additional surfaces. After choosing one, select the directory that 
contains required model or scan. 
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4.6 Positioning the panoramic curve 
 
The panoramic curve (the middle of the three, alternatively five curves which appear in the axial view) 
is generated automatically after CT data import. It is possible to manually adjust it. 
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This can be done by using the slider (1) to identify an axial slice which shows the complete arch/ridge of 
the patient’s jaw. If necessary, it is possible to switch the display mode of the axial slice to an X-ray 
display by clicking button (2). 
The curve as a whole can be shifted by dragging red handle (3), and the width of the curve can be 
adjusted by dragging any yellow handle (4). Dragging the yellow handle within the curve decreases/ 
increases the curve. By dragging any of the grey handles (5) along the curve user can align the curve 
in position as desired. 
Alternatively, the entire curve can be redrawn by pressing the “Draw dental curve” button (6). The user 
can left-click periodically as the mouse moves around the arch (from left to right), placing dots. The 
software will connect the dots to draw the panoramic curve. When the curve is complete, just double 
click, or click on the “Draw dental curve” button (3) again, or press “Esc”. 
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5 Software interface 
 
Blue Sky Plan® allows seamless interaction among the various windows displaying the axial, sagittal, 
coronal, cross-sectional, tangential, panoramic, and 3D images. 
Depending on the intended use, it is possible to select the active windows for multi-planar functions 
(axial, sagittal, coronal, and 3D) or implant functions (cross-sectional, tangential, axial, panoramic, and 
3D). User can switch between different perspectives (in menu bar "View > Perspectives" (1), 
alternatively by clicking on the button  in icon toolbar (2)). Within any perspective, it is possible to 
add any view window (in menu bar "View > Views" (3)). 

 

 

The following information and tools can be viewed in most of active windows: 
• individual colors for each cross section of images, 
• indicators showing the current position of the images, 
• label of the image 
• rulers 

 
5.1 Screens and views 

 
The implant screen allows visualization of the cross-sectional, tangential, axial, panoramic, and 3D 
images. All implant planning tools can be accessed through the menu bar (1) below. The icon toolbar 
and the toolbar of the panoramic image (2 and 3, respectively, in the following illustration) show the 
most-used tools. 



BS-LS-0161-en Rev 4 Blue Sky Plan® 18 2023-08  

 
 

5.1.1 Axial window 
 
The axial images are horizontal slices of the volume and can be seen in the middle top (respectively, 
in the following illustration) view in the application (1). They are marked in blue. All the other images 
are generated from the sequence of axial images. 
By moving the axial slider (2), it is possible to view the whole sequence of axial images. The indicator 
line of the axial slice appears in the cross sectional, panoramic, and 3D images (3). 



BS-LS-0161-en Rev 4 Blue Sky Plan® 19 2023-08  

 
 

5.1.2 Cross-sectional window 
 
The cross-sections, view displays vertical slices going around the patient’s ridge. As the user moves 
through the slices using the cross-sectional slider (1), the corresponding multi-color lines in the axial 
and panoramic views (2 and 3) will move accordingly, identifying the location of the five (three, 
alternatively) images being displayed in the cross-sectional views. 
These images are used to evaluate the bone height and thickness in planning. When implants are 
placed, they are often placed into one of the images in the cross-sectional view. 

The distance separating the images can be modified by clicking on the  icon (4), and a new value can 
be selected from the drop-down menu. By default, the distance between images is set to 1mm. 
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5.1.3 Panoramic window 

 
The panoramic image is located in the bottom right-hand window of the application (1) and is marked 
with light green. 
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The indicator line of the panoramic slice appears in the cross-sectional (2) and axial (3) views. As the 
user flips through the panoramic images, the panoramic curve will move along the horizontal axial 
plane to indicate the location of the specific slice represented by the location of the panoramic curve. 
The range of the field of view reachable by the panoramic curve can be adjusted by clicking on the 
offset distance icon (4) and by choosing an appropriate step. The change in the range of slices 
reachable by the panoramic curve will be represented by a change in the distance between the inner 
and outer panoramic curves. 

The view mode button  (5) will change the panoramic view into a composite image representing an 
image similar to an X-ray. In such a situation the panoramic curve in the axial view will disappear, as 
no individual slices are being represented, and instead a composite image of all the slices within the 
relevant range is displayed. Selecting the view mode button  again will return the panoramic view to 
the standard section view. 

 
5.1.4 Tangential/implant window 

 
The tangential view is located in the upper right-hand part (1) of the application and is marked in green. It 
works in two modes. If no implant is active, it displays the view orthogonal to the cross- section view 
(tangential to the curve). 
The plane displayed can be rotated with the slider in the tangential view window (1) or by dragging the 
line displaying the intersection of the plane with the axial slice in the axial view window (2). The 
direction of view on the plane of the tangential slice is indicated in the axial view with a green triangle. 
If an implant is active, the view orients itself in a tangential position to the curve when switching to the 
implant. Nonetheless it does not display the perpendicular plane but rather the plane passing through 
the implant. In this mode the orientation of the plane is indicated not only in the axial view but also on the 
associated implant in the 3D window (3). 
If the implant is rotated in a different view, the plane displayed in the window (1) automatically changes to 
the rotated plane of the implant. 
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Thanks to the option of rotating the plane passing through the implant, it is possible to easily check 
and correct the tilt of the implant's position when viewing from any angle. 

 

 
5.1.5 3D View 

 
The 3D image is located in the bottom left-hand view of the application (1). To rotate the 3D image, 
click and hold the left mouse button in the model, and to zoom, click and hold the right mouse button. 
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5.1.6 3D Shortcut buttons 
 
The 3D view has several valuable shortcut buttons on the right side of the view. 
The first button (2) maximizes the window. 
The second button (3) allows the user to change the positioning of the view. The user can click on the 
button to open a fly out menu. The orientation of the patient’s anatomy will adjust according to the 
option chosen. 
The third button (4) allows the user to take advantage of different volume rendering options. It is 
possible to set the rendering type and quality using the contextual menu options or the Volume 
Rendering panel, which can be accessed from the menu under the "Panels" option. 
The “Presets” option opens a selection of different 3D volume rendering presets with different coloring 
schemes. 
In “Surfaces” mode, differential surfaces (“CT surfaces”) are depicted (1) that are defined in the 
“Surfaces” panel, which can be accessed from the main menu under the "Panels" option or by double- 
clicking in the 3D window. 
The user can assign a name to each density surface and set threshold values, the color, or the 
transparency. 
In the “STL Surfaces” table located on the same panel (2), users can find created or imported models 
for which it is possible to set the color, visibility, and transparency. 
The visibility of STL models, unlike that of CT surfaces, is not affected by the chosen volume rendering 
mode. 
The fourth button (5) turns on the visibility of the slices in the 3D window. 
The fifth button (6) inserts a current snapshot of the 3D window into the "Screenshots" panel. 
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5.1.7 Surface culling (3D cut) 
 
 
A 3D visualization can be cropped with the Surface Culling function (3). In “Surfaces” mode, each CT 
surface is cropped independently of the others. The first non- 
deletable surface shares its cropping area with the other 
visualization modes (Shaded Bones, MIP, X-Ray, etc.). 

 
Cropping serves to: 

• remove noise 
• remove superfluous anatomy 
• isolate anatomy 

 
The cropping tools are in the lower part of the “Surfaces” 
panel (3). It is possible to crop data with the "Cut" button, to 
delete a previously performed crop with the "Clear" button, 
and to isolate the selected anatomic portion. It is also 
possible to invert the current cropping. 
After the user clicks the “Cut” button, the application switches 
to drawing mode. At this point, by clicking on the left mouse 
button in the 3D window and dragging the cursor, it is 
possible to draw an area which is cut out of the selected 
surface after when the mouse button is released. Drawing 
can also be invoked at any point by pressing the “Shift” key 
and holding it down during the whole drawing period. 
If we want to isolate a particular part of the anatomy, we must 
first ensure that it is not connected to any other parts. We can 
ensure this using the cropping function described above. We 
can isolate anatomy in this way with the “Isolate” button and 
by clicking on it in the 3D window. All parts of the anatomy 
are then removed except for the selected part. 
As soon as we have a cropped part of the anatomy that we 
want to display, it is possible to invert the cropping with the 
Invert check box. 
Any cropping actions can be reversed using the “Undo” 
function. 

 
 
 
 
 
5.1.8 Indicators 

 
The indicators are reference lines that indicate the positioning between the images shown on the 
screen. 
Usually, the indicators are already enabled in the windows of 2D images. To disable them, click “View > 
2D” in the menu and choose the indicator to be disabled. 
It is also possible to enable the indicators on the 3D images. Click “View > 3D” in the menu and 
choose the projection type to be enabled on the 3D image. 
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To change the visibility of objects such as implants or teeth, it is possible to use the associated panels, 
the buttons in the icon bar (1), or the “View > Objects” option in menu bar (2). After switching the 
visibility of the dental curve and slice indicators in the 2D views, it is now possible to use the “All 
projections” ("Hide all projections", alternatively) icon  in the icon bar. 

 

 
5.2 Multi-planer screen 

 
To access the multi-planar screen, click the “View > Perspectives > MPR” menu option. The multi- 
planar screen makes it possible to view coronal, axial, sagittal, and 3D images. This screen is 
generally used for applications such as oral and maxillofacial lesions and defects, removal of impacted 
teeth, and treatment of temporomandibular joint pathology. 
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To locate the desired image, move the slide bar located next to the windows. Indicator lines show the 
exact image position of one window in relation to the images in the other windows. 

 
 

5.2.1 Sagittal window 
 
The sagittal image is a vertical plane that divides the skull into a right and left side. It is located in the 
bottom left window of the software (1) and is marked in yellow. When the user moves the scrollbar of 
the sagittal window (2), the whole sequence of images in this group will be shown. The indicator line of 
the sagittal slice appears in the coronal (3), axial (4), and 3D images. 
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5.2.2 Coronal window 
 
The coronal image is a vertical plane that divides the skull into a front and back part. This image is 
located in the top right-hand window of the application and is marked in pink. When the user moves 
the scrollbar in the coronal window, the whole sequence of images in this group will be shown. The 
indicator line of the coronal slice appears in the axial, sagittal, and 3D images. 

 
5.3 3D Mouse Controls 

 
BSP allows the user to use a 3D mouse. In order to use it, please download the software from this 
web page https://3dconnexion.com/drivers/. 
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After installation, open the 3Dconnextion Settings and click on Buttons (2) to open the buttons menu. 
Make sure you have set Blue Sky Plan (1) for 3D mouse settings. 
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In the buttons menu for Blue Sky Plan, set left and right mouse buttons (3) for controls. Blue Sky Plan 
allows the user to set controls (4) for: File, Objects, Orthodontics, Panels and Perspectives. 

 
 

 

The user is able to set basic functions such as undo/redo, copy/paste or camera controls. You can 
also set BSP functions which control the program’s UI. 
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The controls (5) for the 3D mouse for Blue Sky Plan have now been set. 

 
 

 
All options can be restored by clicking on the "Restore Defaults" button. For more advanced settings, 
click on the "Advanced Settings" button. 
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6 CT Dicom Viewer 
 
CT DICOM Viewer simplifies working with CT Data, especially for reviewing CT scans. To start a new 
project, click on the CT DICOM Viewer button (1) and choose DICOM data (2). By clicking on 
“Customize Field of View and Rotation” (3), the user is able to align the dataset and select the volume 
of interest. If this option is not selected, the user continues to CT DICOM Viewer without selecting the 
volume of interest or alignment. 

 
CT DICOM Viewer can be set as the “shell open module” in Preferences -> Advanced (i.e. the default 
module in which data is opened “when double-clicking”). 

 
CT DICOM Viewer is based on the Model Editing module, and the main differences between the two 
are: 
• Projects saved in CT DICOM Viewer will be opened in the Model Editing module 
• UI changes done in CT DICOM Viewer are not saved (toolbars, panels…) 
• “Import Additional Surface“ dialog doesn’t appear in CT DICOM Viewer 
• Only the Main Toolbar, Measurements Toolbar, and Messages Toolbar are activated by default 
• Brightness/Contrast, Ortho Slices, Volume Rendering, Surfaces, Notes List, Nerve List, and 
Screenshots panels are available by default 
To work with additional tools (chapter 7), select the Model Editing or Surgical Guides (chapter 15) 
modules from the Main Screen or switch to the Normal/Advanced module. 
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7 Placing implants and pins 
 
Blue Sky Plan® allows virtual implant planning via the patient’s CT or CBCT images. It is possible to 
add, exchange, move, and rotate the implant and abutment or pin in the different views. 

 
7.1 Adding an implant or pin 

 
7.1.1 Implant from the catalogue 

 
Before positioning the implant, it is recommended to first measure the dimensions of the bone. In this way 
it is possible to estimate what dimensions the implant should have. Clicking on the  icon in the toolbar 
opens a dialog for adding an implant. 

 

In this dialog it is possible to modify the implant parameters, abutment, and drill guide. The 
corresponding parts can be selected in the individual tabs (1). “Select Implant” (2) is selected by 
default, which makes it possible to select an implant from the catalogue (3) on the basis of its type (4) 
and platform (5) and then according to parameters (6). It is also possible to specify the orientation of 
the implant (7). The currently selected implant can be viewed in the preview (8). A short description of 
the implant (9) is also located in the lower part of the dialog. 

 
7.1.2 Custom implant 

 
If none of the implants fulfills the particular requirements, it is possible to create a simplified but fully 
parameterized implant. This is achieved by clicking on the "Custom Implant" option (1). The individual 
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parameters (2) can be modified with the corresponding fields. These changes appear immediately in 
the preview. 

 

 
7.1.3 Abutment from the catalogue 

 
By default, the implant is loaded without an abutment. If we want to add an abutment, it is necessary 
to first switch to the "Abutment" tab (1) and then select the "Select Abutment" option (2). A list of 
abutments that are compatible with the selected implant appears in the table (3). Once we have 
chosen a parameterized implant, a table for selecting the type and platform will be displayed here 
similarly as for the implant. 
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7.1.4 Custom abutment 
 
The abutment can also be fully parameterized in the same way as the implant. We first select “Custom 
Abutment” (1); it is then possible to set the individual parameters (2). 

 

 

7.1.5 Drill guide 
 
The implant has an auxiliary drill guide added by default. If we want to modify it, it is necessary to 
switch to the “Software Guide Tube” (1) tab. Its parameters can be changed in the corresponding fields 
(2). If we want to display it or hide it in the preview, we can use the check box (3). 
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7.1.6 Pin from the catalogue 

 
Instead of an implant, it is possible to add a pin (1). This is a special implant for positioning a template 
more firmly. In contrast to an implant, it cannot have an abutment but only a drill guide. 
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7.1.7 Your own pin 
 
It is also possible to adjust your own pin similarly as for previous parts (1). Length 0 (2) sets the length 
of the blue part of the pin; length 1 (3) then sets the length of the green part. 

 

 
7.2 Positioning and manipulating the implant 

 
We confirm the choice of implant in the dialog by pressing “OK”. The mouse cursor then changes to 

 . We can then position the implant by clicking on the slice and, if necessary, on the 3D visualization 
in any window. After being added, the implant is always positioned perpendicular to the selected 
orientation. It is up to the user to fine-tune the position and rotation. 
It is possible to move the implant in all of the windows. This is achieved by moving the cursor onto the 
implant, clicking the left mouse button, and dragging. The implant always moves in the plane of the 
view. 
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Besides moving it, it is also possible to rotate it using the so-called draggers. These are displayed 
when you position the cursor on the implant, its abutment, or the drill guide. If we move the mouse 
cursor onto the dragger and click the left mouse button, the dragger changes color, and by dragging 
the mouse we can modify the rotation of the implant. 

 
7.3 Further operations on the implant 

 
7.3.1 Toolbar 

 
In the upper menu bar it is possible to display a toolbar of further operations on the implant by 
selecting “View > Toolbars > Implants Toolbar”. Here are icons for removing the implant (1), replacing 
the implant (2), displaying information about the implant (3) and Endo mode for placing implants by tip 
((4) see chapter 17). 

 

Operations 1 and 3 are used in the same way: we click on the icon, move the cursor onto the implant, 
and click on it. For the option of replacing the implant (2), the same dialog appears as when adding the 
implant, in which we choose which implant we want to replace the selected implant with. 

 
7.3.2 Context menu 
 

It is also possible to perform several operations on the implant via 
the context menu, which we can invoke by clicking the right 
mouse button on the implant. 

 
It is possible to display the implant ID (a short editable description 
of the implant) or its properties. It is also possible to lock the 
implant against edits. The locked implant has a padlock icon 
displayed next to it. It is similarly possible to replace and, if 
necessary, add an abutment. The entire implant can be duplicated 
or aligned with another implant. That means that although the 
implant remains in its position, it turns in the space in such a way 
that its axis is parallel to the axis of another implant. A complex 
implant replacement can also be performed from the context 
menu. The implant can also be removed. Besides this it is 
possible to change the point around which the implant rotates 
during manipulation (the so-called Pivot). It is possible to cancel 
selection of the active implant via the context menu. Finally, the 
visibility of individual parts of the implant can be changed 
(“Visibility > Implant/Abutment/Software Guide Tube”). 
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Pivot set to Center. The implant rotates around its center. 
 
 
 
 
 
 
 
 
 
 

Pivot set to Head. The implant now rotates around its head. 
 
 
 
 
 
 
 
 
 
 
 
 

Pivot set to Tip. The implant now rotates around its tip. 
 
 
 
 
 
 
 
 

7.4 Side panel 
 
To make it easier to find our way among implants, the side panel can be displayed via “Panels > 
Implant List”. 
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It contains a list of all the implants (1), settings for the 
transparency and visibility of outlines (2), the parameters of 
the active implant (3), its abutment (4), and the drill guide (5). 
For a pin, the properties of the pin are displayed instead of 
the properties of the implant and abutment. For the implant 
and abutment sections, there are also “Customize” and 
“Replace” buttons. The “Customize” button replaces the 
implant with its fully parameterized variant. “Replace” opens 
the same dialog as for adding an implant and makes it 
possible to replace the implant with the selected variant. 
Several properties of the implant can be changed quickly in 
the list of implants. One is the ID (6), which is a short 
description of the implant. It is possible to change the 
visibility of the ID by double-clicking on it and to toggle its 
visibility in the windows with the check box. The check box 
under the implant (7) changes the visibility of the implant, the 
check box under the abutment icon (8) toggles the visibility of 
the abutment, and the check box under the drill guide (9) 
changes the visibility of the drill guide. All the visibility 
settings are independent of each other. Finally, for every 
implant there is an icon for removing it (11) and locking it 
(10). 

 
 
 
 
 
 
 
 
 
 
 
 
 

7.5 Dialog with the parameters of the selected implant 
 
The parameters of the implant can be displayed from the context menu. If the side panel is displayed, 
then the associated implant is selected in this panel, and its parameters appear. If this panel is hidden, 
a special dialog appears when the user attempts to display the parameters. It again displays the 
implant ID (1), the parameters of the implant (2), the parameters of the abutment (3), and the 
parameters of the guide tube (4). For a pin, the parameters of the pin appear here instead of the 
parameters of the implant and abutment, similarly as in the side panel. 
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7.6 Validating implants 
 
All implants are validated on the background. That means that their positions with respect to each 
other and to the nerves are checked. If an implant is evaluated as invalid, the  icon appears next to 
it. 

 
 
 

The first criterion considered is the distance between implants. 
If two implants are too close to each other, both are evaluated 
as invalid, which is represented by the appearance of icons 
over both implants. 

 
 
 
 
 
 

The second criterion is the angle between implants. If this angle 
is too large, the implants are again evaluated as invalid, despite 
the fact that they are relatively far apart. To fulfill the validation 
criteria, we must reduce the angle between the implants and, if 
necessary, to increase the distance between the implants again. 

 
 

The third criterion is the distance from the nerve. The same considerations apply here as for the 
distance between implants. 
If you are not certain why the validation had failed, you may open a panel with the validation results via 
“Panels > Implant Validation”. In this panel it is also possible to set the validation parameters (1). 
There is a list here of all invalid implants (2) and the reasons the validation of the selected implant 
failed (3). 
Note: pins are not validated either against themselves (or implants) or against nerves. 



BS-LS-0161-en Rev 4 Blue Sky Plan® 42 2023-08  

 
 

7.7 Ordering implants 
 
Implants can be ordered directly from the application by selecting Order Parts in the toolbar. 

 

The Blue Sky Bio website will load automatically, and the implants which were used in the treatment 
plan will be added automatically to the shopping cart. Additional implants and items can be added to 
the shopping cart by continuing to shop via the website. 
If custom implants were used (implants that were not selected from the Blue Sky Bio catalog) in the 
treatment plan, those implants will not be added automatically to the shopping cart. 
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8 Tools 
 
This chapter explains the properties of each Blue Sky Plan® tool and the toolbar that contains the 
most-used tools in the application. 

 
 
8.1 Toolbar 

 
1 – Menu bar (access to all the software tools) 

2 – Icon bar (fast access to the main tools) 

3 – 3D view icons (view rotation, volume rendering settings, and visibility of slices) 

4 – Panoramic icons (offset step, X-ray mode, etc.) 
 

 
Further toolbars can be displayed by means of the context options in the main bar or via the option 
“View > Toolbars”. 



BS-LS-0161-en Rev 4 Blue Sky Plan® 44 2023-08  

8.2 Opening a project 
 

 
8.3 Saving a project 

 
 
 
 
 
 
 
 
 
 
 
 
 
After clicking the "File > New Project" (1) menu option the 
application will return to the main menu. You can create 
new project by selection of planning type. Already existing 
project you can open by clicking the "File > Open 
Project" (2) and the most recent used project you can 
open through the "File > Recent Projects" (3). 

 
To save a modified project, click the “File > Save Project” (4) menu option. To save a project under a 
new name, click the “File > Save Project As” (5) menu option. 

 
 
8.4 Closing a project 

 
To close a project file, click the “File > Close project” (6) menu option. 

 
 

8.5 Saving images in JPG format 
 
To save the currently visible screen images in .jpg format, click on the “File > Save Image” (7) menu 
option, then choose the folder where you want to save the images or PDF file. 
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8.6 Saving screenshots and generating a Drill Report 
 
Screenshots can also be captured individually using the "Screenshot" button (1) located on the right 
side of each view. Captured screenshots are inserted into the list in the “Screenshots” panel (2), which 
can be accessed from the "Panels" menu. 
For most slices this makes it possible to extract not only the current view, but also all further possible 
slice positions with the current settings. Snapshots are captured in the size corresponding to the 
current window size and the setting (3) in the "Screenshots" panel. 

 

Using the context menu options by clicking the right mouse button (4) in the list of screenshots (2), it is 
possible to copy the selected screenshot to the clipboard, save it to disk, or remove it from the list. The 
screenshot can be displayed in its original size by double-clicking on the preview. 
Snapshots can be saved individually in the selected bitmap format (5), a PDF document of all the 
windows can be created (6), and the document can be printed out directly (7). 

 
8.6.1 Drill report 

 
A set of screenshots can also be created with the "Drill Report” button (8) which creates a set of 
snapshots containing the 3D view, the panoramic view, and a pair of the normal and tangential view for 
each planned implant. 

 
8.6.2 PDF export and print settings 

 
When exporting to a PDF file and printing, the layout of the images on the page can be selected 
in the "Page layout" section (1). In "Downsize only" mode (2) the program will not enlarge the 
images and will attempt to maintain their actual size. 



BS-LS-0161-en Rev 4 Blue Sky Plan® 46 2023-08  

 
 

The document created can be supplemented with a user header (3) and footer (4), basic information about 
the patient and project (5), a table of implants (6), and a description of each image inserted in the 
image (7). Once the settings are confirmed, the document created appears in the preview window. 



BS-LS-0161-en Rev 4 Blue Sky Plan® 47 2023-08  

 
 
 

8.7 Modifying window and level 
The display brightness and contrast of density data can be changed in the "Brightness/Contrast" 
panel (2), which can be accessed from the "Panels" menu (1). The brightness and contrast can 
also be changed with a special mouse mode (3) in which movement along the horizontal axis 
while pressing the left mouse button changes the brightness, and movement along the vertical 
axis changes the contrast. 
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8.8 Zooming 
To zoom in, press and hold down the right mouse button and drag the mouse up or down. 

A second option is to select the zoom icon  (as shown below) and hold down the left mouse button 
while moving the mouse forward or backward. 

 

 
8.9 Moving the image 

 
Click on the Move Image icon  and drag the image as desired. An image can also be moved by 
holding down the mouse wheel (pressing it, not scrolling it) and dragging the image. 

 

 
8.10 Moving objects 

 
In the default mouse mode (represented by Trackball Mode icon  in the icon bar), left-clicking 
changes the position of the slice. If the mouse cursor is positioned over an object that can be 
manipulated, the mouse cursor changes, and the object can be moved, and if necessary its angle of 
rotation or size can be changed using the displayed dragger. 
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8.11 Measurements and overlays 
 
Users can perform any measurement of density (1), length (2), or angle (3) in 2D images. They can 
also insert arrows (4), text descriptions (5), or rulers (6). 
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8.12 Linear measurement 
 
Click the “Tools > Distance Measure” menu option (2) in order to perform any 2D measurements. 
Click the left mouse button with the pointer on the image to mark the start point of the distance to be 
measured and click again on the image to mark the end point of the measured distance. To correct the 
measurement you can grab one of the end points and move them. 

 
 
8.13 Angular measurement 

 
Click “Tools > Angular Measure” menu option (3). Click the left mouse button with the pointer on the 
image and repeat the process twice to get an angle. To correct the measurement you can grab the 
points specifying the angle. 

 
 
8.14 Density measurement 

 
Click the “Tools > Density Measure” menu option (1). The value of the density measurement is 
obtained from the information contained in the patient's image and can vary for each CT or CBCT 
scan. The measurements are given in Hounsfield units. 
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8.15 Measurement correction and number position 
 
The user can correct the measurement and all the overlays in the default mouse mode. It is possible to 
correct a measurement by clicking at the edge of the measurement with the left mouse button and 
dragging. It is also possible to position the numerical value of the measurement outside of the image. 

 
 
8.16 Deleting a measurement 

 
It is possible to erase a measurement in two ways: 

 
a) Click the measurement edge or click on the number with the right mouse button. A menu will 

appear with the deletion option. 
b) Click the “Panels > Notes List” menu option. A panel will appear (7) with a list of all 

measurements, their types, values, and colors. To erase a measurement, click the X beside the 
measurement. 

 
 
8.17 Overlays 

 
To add text or other types of overlays, select the corresponding action from the “Tools” menu. Specify 
the position of the item in the selected window by clicking on it. The inserted overlay is bound to a 
specific position in the slice; it will not be visible for other positions. Orthogonal slices and the normal 
slice can be positioned in the location of an overlay by double-clicking on the "Note Type" field (1) or 
"View" field (2) of the associated item. 

 

The text of an overlay can be changed by clicking on the “Note” field in the “Notes List” panel (7) or via 
the context menu on the item in the associated slice. The color of several types of items can also be 
changed in the "Notes List" panel by clicking on the “Color” field. 

 
 
8.18 Panoramic 

 
A panoramic image is a panoramic slice of the mouth and teeth. It is a perpendicular plane of the axial 
image. 
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8.18.1 Creating a panoramic line 

 
Refer to Section 4.6. 

 
 

8.18.2 Mandibular canal 
 
The mandibular canal can be added in the panoramic image and viewed in all of the images. 

 
 

8.18.3 Adding a mandibular canal 
 
Adjust the panoramic curve to fit the patient’s arch as described in section 4.6. Click on the "Add 
Nerve" button either located in the icon bar or under the "Tools" option in menu bar (1). The Nerves 
panel (2) will appear to show default properties for the nerve (3). Click on portions of the nerve in the 
panoramic window and follow the canal to the mental foramen. 
When entering nerve points, the position of the slice can be changed with the scroll bar on the right 
side of the window, and the last-added point can be removed with the "Edit > Undo" action. You can 
fine tune the buccal/lingual aspect by adjusting the nerve point in the cross-sectional view later. Add 
another nerve by clicking the “Add Nerve” button (4) on the Nerves panel, and repeat on the other 
side. All images should show the nerve with a default diameter in yellow. 
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It is also possible to add nerve by clicking the button "Detect Nerve", where adding whole nerve canal 
happens by clicking inside the mental foramen in the corresponding slice of the cross-sectional view. 
You can also use the fully automatized nerve detection by clicking the button "Autodetect Nerves". 

 

 
 
 
8.18.4 Changing mandibular canal parameters 

 
Clicking on the color of the nerve in the list (2) opens color selection window. After choosing, confirm 
your selection by pressing “OK”. The width of the nerve is displayed in the adjacent column. This can be 
changed either by clicking on the window and entering new values or by repeatedly clicking on the arrows 
beside it to change the value in increments of 0.1 mm. 
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8.18.5 Deleting the mandibular canal 
 
Select the “Panels > Nerve List” menu option and click on the letter X beside the nerve to be deleted. 

 
 

8.18.6 Canal display in different panoramic view modes 
 
As described in Section 5.1.3, within panoramic view it is possible to switch between composite mode 
and slice display mode. In composite mode, the entire mandibular canal is displayed in the form of an 
outline, including all control points (see image). In slice mode, only the control points near the 
panoramic plane are visible. The mandibular canal itself is only displayed in the form of slices of the 
same plane 

 
 
 
 
 
 
 
 
 
 
. 
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9 Importing the Scan Appliance 
 
The Blue Sky Plan® Scanning Protocol calls for two CT scans. The first scan should be of the patient 
wearing a Scan Appliance, and the second scan should be of just the Scan Appliance. Since the Scan 
Appliance is made of mostly radiolucent material, the Scan Appliance does not appear in the patient’s 
scan. 

 
It does however appear when scanned alone, since the relevant density of the Scan Appliance is 
greater than the density of air, causing it to appear in the scan. The software allows the two scans to 
be merged in order to have the Scan Appliance appear in the scan of the patient.Merging the Scan 
Appliance assists with proper treatment planning as it shows the position of the future teeth and 
removes any artifacts which may have previously appeared in the area of the teeth. 

 
Follow the steps below to import the Scan Appliance: 

 
1) Load the DICOM set of the patient into the Blue Sky Plan application. 

 
2) In the "Model Master" module, choose “File > Import DICOMS >Scan Appliance". Follow the 
prompts to identify the location of the Scan Appliance DICOMs and select the relevant region of 
interest, selecting only the range containing the Scan Appliance. 

 

Importing Scan Appliance is also possible through the "Model Master" module within the main screen. 
After choosing "Model Master > Import Pacient CT Scan", follow the further prompts and select the 
region of interests (as described above). After that, the window with types of additional surfaces 
appears. Choose "Import CT Scan of Denture or Scan Appliance with Markers". 
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3) In the process of alignment, you can use the buttons to toggle simultaneous display of the patient 
data gutta markers (white) and Scan Appliance (red). You can display or hide the Scan Appliance 
model with button. 

 
The top left-hand box contains the gutta markers from the patient’s scan. The top right-hand box 
contains the gutta markers of the Scan Appliance. The bottom left-hand box contains an image of the 
Scan Appliance. The bottom right-hand box displays both sets of gutta markers if they coincide. 

 
9.1 Gutta percha markers coincide 

 
If the two sets of markers do coincide, we continue as follows. If they do not coincide, proceed to 
section 9.2. 
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4) Confirm the data alignment by pressing “OK”. 

 
5) The Scan Appliance will appear in the 3D image of the patient’s jaw. The properties of the Scan 
Appliance can be changed in the “Surfaces” panel in the “Imported Surfaces” table. 

 
9.2 Gutta percha markers do not coincide 

 

4) In the top right-hand box use the zoom tool (right mouse button), the 3D density slider, and the 
rotation tool (left mouse button) to clearly view at least four gutta markers. Identify the gutta markers 
by clicking the button or pressing the "Shift" key followed by left mouse clicks on the gutta markers. 
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An erroneous identification of one marker can be reversed with button. If necessary, all identifications 
can be canceled with button. 

 
5) Repeat the previous step for the top left box to identify the patient’s markers. 

 
6) Perform the alignment on the basis of the gutta markers identified by pressing the "Update" button. 
If the result does not roughly correspond to what is desired, identify more points for alignment or, for 
data with gutta markers that are hard to discern, check “Align points only”. Under this setting the 
program aligns the points identified without reference to dimensional data. The alignment can also be 
corrected manually using the dragger in the lower right-hand window. 

 
7) The Scan Appliance will appear in the 3D image of the patient’s jaw. The properties of the Scan 
Appliance can be changed in the “Surfaces” panel in the “Imported Surfaces” table. 

 

10 STL model import (planning with CT 
scan) 

 
Existing STL models are imported into Blue Sky Plan® by selecting “Import STL Model” option from 
automatic pop-up menu after Patient CT Scan Importing. Another possibility is selecting “File > Import 
STL Model”. 

 

After the model has loaded, the Blue Sky Plan Automatic Alignment asks for model orientation and 
attempts to align the model automatically. You can use the “Model Manipulation” panel to position the 
model to desired location as well. 



BS-LS-0161-en Rev 4 Blue Sky Plan® 59 2023-08  

 

 

 
If the model is already aligned with respect to the data, the “Direct” should correspond to the correct 
position of the model. For STL models created with different software than Blue Sky Plan®, use the 
“DICOM” alignment. "Center" places model into middle of the scene without performing any rotation. 

 
Because automatic alignment is usually not precise enough, Blue Sky Plan® also makes it possible to 
perform the alignment by entering a pair of points corresponding to each other. If you select “Points”, a 
dialog appears for entering points manually. The surface model displayed in the left-hand window of 
the dialogis created on the basis of the settings of the currently selected density surface. You can also 
significantly influence the time it takes to create the model and the visibility of appropriate reference 
points by setting the thresholds of the density surface appropriately. 
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Points can be added by clicking on the button with the eyedropper or by pressing the Shift + Left 
click. If “Refine using ICP” is activated, the program attempts to perform an additional automatic 
alignment after the alignment based on the points entered. 

 
A similar point based way of alignment is “Scaled” (works extra with scale) and “To Teeth” (works with 
the panoramic image instead of the surface model). 

 
It is also possible to align the model manually in the 3D window using the dragger that appears when 
you press the “Manual” button. Clicking this same button closes the manual alignment mode, and the 
dragger disappears. 
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When aligning manually, it is possible to define a fixed point (a so-called pivot) around which the 
model rotates. In 2D views, the pivot is represented by a cross. By dragging the cross, it is possible to 
move the model in the plane of view. The model can be rotated using the blue circle. Hold Shift and 
click the left mouse button to position the pivot at a different position in 2D views. In the 3D window, 
the pivot can be repositioned using the small dragger arrows. 
 

11 Planning without CT scan 
 
Blue Sky Plan® software also allows planning for cases without a CT scan – STL models only. 

 
If a user plans a case without a CT scan, the imported models might not be oriented properly (the 
orientation does not match the head in the bottom left of the 3D view). This makes planning very 
difficult. For these cases, Blue Sky Plan has a model alignment dialog, which opens when selecting 
the planning type of the “Import models”. 
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You can import one or several models. For alignment, it is necessary to select the primary model 
(ideally Maxilla) through which the alignment is done. The user also needs to specify if the model is a 
Dentated Arch or Edentulous Arch. 
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In the next step, the user marks three dots on the model (by holding Shift + Left mouse button 
clicking) to help the software align the models properly (to match the orientation of the BSP coordinate 
system). The rest of the models will be aligned relative to the alignment of the primary model. 

 

In the last step, the user can manually fine-tune the primary model using the grid. If several models 
were imported, they will move together as a group. 
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12 STL model adjustment 
 
Blue Sky Plan software allows the user to select and remove part of the surface (model) and close any 
holes which can be created during the process. 

 
All the necessary tools are available in the Model 
Edit panel. Using the “Selection Brush” the user 
can select a part of the surface and remove it by 
pressing the “Cut Selected Area” button. This way 
the user can clean the surface from scuttered 
parts or “extract” a tooth, for example. The 
selected area can be cleared by pressing the 
button "Clear Selection". 

 
Removing parts of the model, however, will create 
a hole (or several). The “Holes Closing Tool” can 
be used to close them. The user can select and 
close one specific hole using, or select and close 
all of them at once. All selected holes can be also 
deselected. 

 
Note: This tool is made for closing smaller and 
simpler holes. More complicated cases may take a 
long time. The complete closure and repair of the 
model can be done using the “Close Model” tool, 
which also creates a stone model with a base in 
the process. 

 
Surface irregularities can be fixed using “Move 
Outlines”, which can only be used in the 
orthogonal view (it doesn’t work in the 3D view). 
“Add/Remove Brush” is used for the addition/ 
removal of the surface material. “Local Deform 
Brush” deforms the surface at a local point. For 
final modifications and polishing the surface of the 
closed hole, “Smoothing Brush” can be used. 
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13 Scan Body Registration 
 
Blue Sky Plan® has useful functionality that allows the user to register the STL files of the scan bodies 
present in the BSP parts catalog to the scan bodies visible in a scanned model. 

 
Blue Sky Plan® has the ability to convert the scan body (type of abutment that serves as a "post" at 
the time of the scan) to an actual abutment with an implant attached. 

 
Once the STL model with visible scan bodies is imported, clicking on the  icon in the toolbar (while 
"Normal" or "Advanced" mode is active) opens a dialog for fitting the catalog scan body to the scanned 
model. 
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After choosing a scan body from the catalog, it can be placed by clicking on the head of the scanned 
abutment in the model – for the best fit position, it is good to click on the place illustrated by the red 
marker as shown in the catalog scan body preview. 
Once the scan body position is precisely defined, the window with teeth and implants pops up. After 
choosing the desired tooth and implant, the scan body, tooth and implant are automatically aligned 
together. 
It is also possible to align either an existing or a new implant with the scan body by right clicking on the 
scan body and choose the desired option from drop-down menu. 
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Later on, the scan body position can also be refined manually using the common manipulation widget 
in the 3D view. 
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14 Virtual teeth 
 
Blue Sky Plan® makes it possible to insert "virtual" teeth into the project. Using pre-prepared models 
of crowns inserted into the data, we can show the patient the possible result after all planned 
procedures have been performed. Virtual teeth also make it possible to align either a new or an 
existing implant and thus easily visually inspect the respective position of the resulting crown with 
respect to the position of the implant and to plan any abutment. 

 
14.1 Inserting crowns 

 
It is highly recommended to specify dental curve, since the inserted crown will be rotated automatically 
with respect to it. We insert the individual crowns either by clicking on the icon in the main toolbar 
or by using the button in the "Tooth List" side panel (indicated below), or if necessary by choosing the 
“Virtual Teeth > Add Tooth” menu item. 

 
A dialog for selecting crown then opens. Clicking on the associated tooth (1) selects it, and a text 
description of the crown appears in (2). It is also possible to select from three sizes (3). The 
dimensions of the tooth can subsequently be modified directly in the sequence. We confirm the 
selection by clicking the “OK” button (4); the "Cancel" button closes the dialog without making a 
selection. 
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14.2 Positioning the crown and manipulating it 
 
The mouse cursor changes to a cross when the dialog closes. We can then position the crown by 
clicking on the slice, and if necessary on the 3D visualization in any window. 

 
The crown is positioned in a vertical position according to the type of the simulated tooth and rotates 
with respect to the dental curve. It is up to the user to fine-tune its position. 

 
The tooth can be moved in all the windows. This is achieved by positioning the mouse on the tooth 
geometry, clicking the left mouse button, and dragging. The tooth always moves in the plane of the 
view. The tooth can also be rotated using the so-called draggers. These appear again when the mouse 
cursor is positioned on the tooth. We can subsequently grab the dragger by clicking the left mouse 
button; the dragger changes color, and we modify the rotation of the tooth by dragging. 

 

 
The rotation point (the so-called Pivot) can either be in the center of the tooth geometry or at the 
beginning of the local coordinate system. This is located in the same place as the head of the aligned 
implant. 

 

 
In the 3D view, the tooth can be dragged not only in the plane of the view but also along the axis of the 
tooth. As in the other views, it is necessary to move the cursor onto the tooth and display the draggers. 
The blue arrows above and below the tooth serve to shift it along the axis. We change the position of 
the tooth by moving the cursor to the arrow, clicking the left mouse button, and dragging. As for 
implants, three differently colored circles appear in the 3D view for rotating the tooth around the 
corresponding axes of the local coordinate system. 

 
In addition to the position and rotation, the size of the crown can also be modified in the 3D view. 
Spheres displayed along the axis of the tooth serve to change the size. We change the size of the 
tooth by moving the cursor to it, clicking the left mouse button, and dragging. 
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14.3 Aligning an implant and further operations 
 
The side panel, which can be opened with the “Panels > Tooth List” menu option, provides further 
operations on the tooth. A list containing a description of the tooth (1), a check box (2) for turning the 
visibility of the individual tooth on and off, and a button to remove the given tooth (3) appear in this 
panel. The currently selected tooth is displayed in red in the sequence, and the associated row is 
highlighted in the list. 

 
As for implants, it is also possible to set the transparency (4) or outline display (5) for teeth. 

 
There is also an "Add Tooth" button here for adding a tooth (6), which functions the same way as the 
toolbar button described above, optionally via a menu item. 
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The result of clicking the “Remove Tooth” button 
(7) depends on whether a tooth is designated as 
selected. If so (if one of the teeth is designated), 
the action is performed directly on the designated 
tooth. If not, the selected tooth is removed from 
the sequence by clicking the mouse. The button 
for changing the geometry of the tooth is “Replace 
Tooth” (8). The dialog for selecting the new 
geometry works analogously: if one of the teeth is 
selected, the new geometry is set to it; if none is 
selected, the mouse cursor changes to a selection 
cross, and the geometry changes to that of the 
tooth selected by clicking on it. 

 
 
 
 
 
 
 
 
 
 
 
The "Align New Implant” button (9) first opens a dialog for selecting the implant (see chapter 7), and 
after the selection is confirmed with the “OK” button, the new implant is added to the project with the 
position setting corresponding to that of the selected tooth. 

 
The button for aligning an existing implant (10) works analogously. When it is pressed, the mouse 
cursor changes to a selection cross, and when one of the existing implants is clicked on, its position 
with respect to the tooth is modified. 

 
14.4 Context menu 

 
Some operations can also be performed via the context menu. We invoke this by clicking the right 
mouse button on the tooth geometry. Besides the operations described previously, such as aligning 
the implant, removing the tooth, or replacing it with another type, it is also possible here to group up 
tooth with implant and move them together across the scene, and also choose the point of rotation of 
the draggers (the Pivot) as described in chapter 14.2. 
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15 Tooth segmentation 
 
Blue Sky Plan® makes it possible to segment and remove individual teeth from the data. The following 
two segmentation methods are supported. 

 
15.1 Automatic Tooth Segmentation 

 
Using the Segmentation functionality, you can also use: “Automatic Tooth Segmentation“. Two options 
are available – Select Tooth and Create STL Surfaces for All Teeth. 

 
 

 
To work with one tooth segmentation at a time, click on Select Tooth button (1) and choose a tooth 
from one of the orthogonal slices (2) you need to select. The result of the selection will be colored in all 
the slices. A preview of the selected tooth can be shown in the 3D scene by clicking on Show 
Segmentation 3D Preview (3). Tooth selection can be removed from the orthogonal slices by clicking 
on Clear Segmentation Data. 
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Tooth selection can be corrected with the "Refinement Tools" (4). It is also possible to apply a 
“Smooth” filter on the segmentation data. “Inflate” inflates data by one voxel while “Deflate” shrinks 
data by one voxel. 

 
 

 
 
To create a 3D model from the segmentation data, click on “Create Surface” (5). To create a new CT 
surface with the current segment cut out, click on “Cut from CT Surface”. 
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If you want to run fully automated segmentation, click on “Create STL Surfaces for All Teeth” (6). 
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You can check fully segmented teeth in the Surfaces panel. 
 
 

 
 

15.2 Virtual Tooth Segmentation 
 
If automatic delimitation of the tooth fails, it can be selected in the data using the virtual tooth manually 
positioned in the data via the “Virtual Teeth > Add Tooth” option from the main menu. After positioning 
the model, perform the “Use Active Tooth Model” action for the designated data on the basis of the 
tooth model entered. Using the "Model Neighborhood Parameter" it is possible to slightly correct the 
area around the positioned model that has been selected. 

 
 

 

It is possible to transfer the area of the tooth marked in the data into the model by clicking “Create 
Surface”. The model created in this way appears in the “Surfaces” panel in the “Imported Surfaces” 
table. 
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The tooth can be removed from the data by clicking “Remove Tooth”. If you are not satisfied with the 
result, the action you carried out can be reversed with the "Undo" button, and the tooth selection 
parameters can be modified. 

16 Surgical guides 
 
It is possible to fabricate surgical guides in the program on the basis of imported STL models or a so- 
called scan appliance. It is also possible to edit the surgical guide fabricated. Surgical guides are 
fabricated using the functions located on the "Guide" panel (1), which you can open by clicking on the 
" File (or Panels) > Guide Fabrication" (2) menu item (while "Normal" or "Advanced" mode is active 
(3)). The tools are divided into groups according to their purpose. 

 

The first group (4) combines elements used together for both model types. The second (5) contains a 
button for fabricating surgical guides on the basis of a scan appliance model. The third (6) contains a 
function creating the undercut model. The fourth (7) contains all elements for fabricating an offset 
surgical guide from a surface model. The fifth (8) contains tools for creating label text. These are 
followed by panels for creating labels. 

 
The method of fabrication differs according to the type of model being processed. 

 
16.1 Guide fabrication based on scan appliance 

 
Open the “Guide Fabrication” panel. The first section (“Fabrication”) contains all common settings for 
fabricating a surgical guide. The combo box (1) is used to select the input model. 
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Some input models may be damaged – 
they are composed of several parts, and 
their internal structure may not be correct. 
Fabrication of the surgical guide may fail 
in these cases. If the input model is 
damaged, it is possible to try to correct 
the input geometry using the correction 
tool (2) and run model fabrication again. 
When manipulating the model, it is a good 
idea for the option of working with 
implants to be turned off so that they are 
not moved unintentionally, for example. 
The "Lock Implants" checkbox (3) locks 
them. Implants are also locked 

automatically when using certain tools for fabricating surgical guides. 
 
In order to be able to work conveniently with the resulting surgical guide and so that protruding parts 
do not prevent you from working with the tools, it is possible to select automatic alignment of the areas 
above and around the guide tubes. Select "Use automatic brush" (4) for this purpose and then use 
setting (5) to set the diameter of the free area. If these selections are not checked, only an area of the 
same diameter as the given guide tube is enabled above the guide tubes. 
By using "Built-in Drill Stops" checkbox, it is possible to generate in-built drill stop, which enables the 
handpiece head to bottom out to create the proper depth into the jaw (6). 

 
The detail of the resulting model is adjustable (7). The general rule is that the more detailed the model 
is, the longer it will take to generate it, and the slower manual edits with tools such as the Brush Tool 
will take. A model with the “Normal” setting should be sufficiently detailed for most input data. 
At last, the additional properties of the surgical guide can always be adjusted (8). 

 

After entering and checking all settings in the “Fabrication” panel, it is possible to proceed to automatic 
fabrication of the surgical guide. Clicking the "Create Scan Appliance Guide" button in the “Scan 
Appliance” section runs this. A progress bar is then displayed, and once this runs out, the resulting 
surgical guide is displayed automatically. 

 
16.2 Guide fabrication based on scanned surface models 

 
It is necessary to have an input STL model open in this case as well. 

 
First check whether all the settings in the “Fabrication” panel are correct, i.e. whether the correct input 
model is selected, whether or not automatic model alignment is used above the guide tubes, and what 
level of detail is selected for the resulting surgical guide. Further settings specific to fabricating a 
surgical guide from a surface model are found in the “Guide settings” section (8). 

 
When opening a project, the program tries to guess whether it contains maxillary or mandibular data 
and automatically makes the selection. The same test is then also conducted when initiating 
generation of a surgical guide. 
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If the program’s guess does not agree with the actual situation, it is possible to change 
selection manually. 

 

 
 
 
 

Before actually fabricating the surgical guide, it is 
necessary to specify the area that should be 
covered. This is done by drawing and then editing 
border curves directly on the surface of the input 
model. Clicking the "Draw curve" button activates 
drawing mode. The state of the button is indicated 
by a change in color. 

 
 
 
If we are in curve drawing mode, it is possible to manipulate the model without pressing any keys, and 
for the actual drawing it is necessary to press and hold down the "Shift" key. The mouse cursor 
changes shape from an arrow to a cross, and a stroke can be drawn by pressing the left mouse button 
and dragging the mouse along the surface of the model. 
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After sketching the basic shape of the surgical guide, finish the curve by clicking on activated "Draw 
curve" button again. To finish the curve you can also drag the last point (green) onto the initial point 
(red), or click onto the initial point while holding "Shift" key. 

 

The shape of the curve can be edited using individual control points on it. Before actually generating a 
surgical guide, it is a good idea to check its shape in this mode. If needed, you can delete the curve by 
clicking "Clear curve" button and start with drawing the curve again. 

 
As a consequence of fragmentation, errors in some input models, and, in some cases, local 
unevenness in the surface, it can happen that the curve does not correspond to the intended shape 
exactly. In this case, it is necessary to move the nearest points of the erroneous section so that the 
resulting outline aligns; see the following images. 
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After you finish editing, you can run generation of the surgical guide by clicking the button "Create 
Surgical Guide". The now unnecessary cropped curve is hidden automatically at this point. This is 
indicated by the "Show curve" checkbox, which can be used to redisplay the curve. If the curve 
entered and thus the resulting surgical guide do not contain all the planned implants, the user is 
notified and has the option of halting generation. 

 
Once it is completed, the fabricated surgical guide model is displayed in the "Surfaces" panel, where 
its parameters can be changed in the standard way. 

 
The surgical guide can be regenerated with edited parameters and the same curve; the curve is 
merely hidden and can be displayed with selection, edited again, and used to create a modified model. 

 
16.3 Removing undercuts 

 
The “Surgical Guide Insertion Path” function is used to define the direction from which the surgical 
guide will be inserted. Using this function, you can visualise the areas that run “under” the surgical 
guide (undercuts) and may cause problems when inserting the surgical guide on teeth, especially in 
the case of using stiff materials for fabrication. These areas can be removed by clicking on the “Create 
undercut model as byproduct” (generates model with undercuts removed) checkbox. The surgical 
guide fabricated on this model will be easy to mount. 
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The differences between individual outputs can be compared in the following pair of images. On the 
left is a guide on the model with undercuts removed; on the right, all details are preserved. 

 

 
The default Insertion Path Direction angle and default Maximum Allowed Undercut are defined in 
Preferences, Surgical Guide tab. In addition, the Define Insertion Direction From View functionality is 
available from the Guide Panel. Creating an Undercut Model generates a new model that can be 
worked with independently. 

 

 

16.4 Brush tools 
 
Except for the automatic brush tool, the application provides basic tools for manual adjustment of the 
resulting surgical guide: the " Brush Tools. These tools can smooths the surface (i.e. it lowers bulging 
parts and evens out depressions) (1), add or remove material of the surface (2), locally deform the 
material of the surface (3) and edit outlines in the model (works only in 2D)(4). The tool is found under 
"Model master" module, in the "Model Edit" panel. For more information about model adjustments see 
the section 12. 
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16.5 Text tool 
 
The surgical guides fabricated can be supplemented with one or more labels with a 3D profile. This is 
done with the “Text tool”. 

It is first necessary to check whether the correct 
model is selected. If the model is set as invisible at 
this point in time, the user is notified of this when 
he or she tries to insert a label on it. The text is 
inserted into the editing field. At this point, an 
auxiliary display of the text entered is also shown in 
the 3D display window. The text will be located on 
the model at the location at which it is displayed in 
this window. Therefore, it is necessary to position 
the model in the 3D window in such a way that the 

text will be at the right position on its surface. It is also needed to choose one of two methods of 
creating text-depth: emboss or engrave. 

 
Then press the “Apply Text” button. The auxiliary display of the text in the 3D window is hidden, and 
the text is pressed into the surface of the surgical guide. The auxiliary display in the 3D window can be 
reactivated with the “Show label” checkbox. 
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17 Endodontic Mode 
 
Endodontic treatment (also known as root canal treatment) is a treatment sequence for the infected 
pulp of a tooth which is intended to result in the elimination of infection and the protection of the 
decontaminated tooth from future microbial invasion. It is usually done on one tooth and may include 
all 4 roots. 

 
The planning begins with an intro screen titled “Endodontics”, where the user selects the type of 
planning – “Import Patient CT Scan” or “Import Models”. 

 
 

 

 
 
After loading CT data, the user can import additional surfaces. After choosing one, select the directory 
that contains required model or scan. If you plan a case without a CT scan, choose "Import Models" 
type of planning. 

 
 



BS-LS-0161-en Rev 4 Blue Sky Plan® 85 2023-08  

To continue to Endo Mode, click on "Continue to Endodontic Planning" button in the upper right 
screen. 
Another option how to work with Endodontic mode is by clicking on the Main Toolbar -> Implants -> 
Endo Mode(1). It is now possible to create and save the endodontic guide in the guide panel (2). Endo 
mode can be deactivated by clicking on Main Toolbar -> Implants -> Endo. Endo Guide Thickness can 
be set in the Advanced Module in the Guide panel. Open the Guide settings by clicking on the icon  
(3). 

 

Endo mode has to be active in order to set the Endo Guide Thickness. 
 

The user is able to place an implant tip exactly where clicked. The implant pivot is “Tip” by default 
(“Head” with Endo mode turned off). 

 
The user can turn on “Always show selected implant/tooth” for 2D visibility (even when the 
transparency is set to 1.00) and “Move slices to selected implant’s position” to move slices to the 
added implant. Those options are available in Preferences -> Surgical Guide and Endo mode has to 
be active in order to work with it. 
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18 Data export 
 
Most of the project data can be exported from the application in the form of an STL model. The menu 
selection “File > Export Data” is used to export data. 

 
The quality of the export can be set in the dialog, which influences the quality of the resulting model 
but also the time necessary to generate the export. With the check boxes, it is possible to select what 
should be exported from the project. Selection is limited to data that are currently visible in the 3D view 
of the application. Nerves, imported models, implants, density surfaces, virtual teeth and scanbodies 
can be selected. It is possible to export either to a file or directly to the installed VRMesh application 
for a license with a limited number of exports. The number of remaining exports is indicated on "Export" 
button and in the title of the window. Within the currently open project, the number of exports is only 
reduced once. 
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19 External softwares 
 
19.1 Medit import 

 
The goal of the connection between Blue Sky Bio and Medit is to enable scans from the clinician’s 
intraoral scanner to be used directly in Blue Sky Plan. 

 
To import intraoral scans into Blue Sky Plan, choose the case from your scan box that has the status 
“Scan Completed”. Then click on the Export Blue Sky Plan button to export the scan data to the Blue 
Sky Plan application. 

 
 

 
 

 
 

To import a scan from Medit, it is necessary to have a project opened in the Blue Sky Plan. The scan 
will be loaded automatically. 
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20 Articulation pins 
 
For cases when the user needs to 3D print models of the upper and lower jaw in an exact position, the 
Articulation pins function should be used. Articulation pins can be attached to two arbitrary STL models 
(two opposing jaws), and the models with the pins can be exported. 

 
Once the upper and lower jaws are printed (models, denture bases, etc.), the user can insert the male and 
female pins into each other to recreate the exact articulation. Articulation pins can be placed in the Model 
Manipulation Panel in the Surgical Guide Module. 

The user needs to the upper and lower jaw models and click 
the “Add” button. The number of pins can also be changed. 

 
Both of the models do not need to be closed before adding 
the articulation pins. Open models are closed during this 
process automatically. Both of the models should be aligned 
before adding pins. 

 
 

Pins and manipulation widgets will show up. The dimensions of the connecting arms as well as of the 
pins can be changed by dragging the manipulation widgets which appear when the user hovers over 
that object. The arrows allow the pins to be moved to the sides and the scale widgets change the 
thickness of the pins. 

 
It is not possible to drag the pin arms outside of the pins. The default dimensions can be set in 
Preferences, in the Surgical Guide tab, as Default Articulation Pin Arm Width and Default Articulation 
Pin Arm Height. 
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Once the position and size of all pins and arms are tuned, by clicking on the "Create Articulation Pins" 
the final jaw models with the articulation pins are created. The upper and lower jaw models are 
separated for export and prepared with male and female articulation pins so they can be connected in 
the original position. 
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21 Coordinates export 
 
For the purpose of producing a surgical guide, the program has a function for exporting the 
coordinates of implants on the basis of markers that are part of the scan appliance. It is necessary to 
first designate markers which are visible in the data. Open the panel with the coordinates export 
functions from the menu option “File > Export To > GPI Coordinates…” 

 

In the coordinates export settings panel, select the corresponding type of scan appliance (1) and 
corresponding type of jaw (2). A schematic preview of the template currently selected can be displayed 
by clicking on the help button (3). 

 

In the 3D window, view the model from above and adjust the display with the slider so the markers are 
clearly visible. Click button to activate marker display mode (4), and designate markers by clicking on 
them. The order in which the markers are designated must correspond to the order marked on the 
schematic template. If no order is prescribed then markers can be selected in any order. The markers 
can be designated in all available views and their position is automatically adjusted for the best fit. 
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If you make a mistake when entering a marker, the most recently entered point (5) or all points (6) can 
be removed by clicking the corresponding buttons or with a right click on a marker when the marker 
selection mode is active. The coordinates are actually exported when you click the “Create Report” 
button (7). For a license with a limited number of exports, the number of remaining exports is indicated 
on the button; the number of exports is only reduced by one each time the project is opened. 
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22 Blue Sky Plan Wizard 
 
For easier cases of implant planning in the Normal Mode there is the Blue Sky Plan Wizard tool. The 
tool allows case processing in the form of partly automated sequential steps with help. To start the 
Wizard, first select in the main screen "Implant Planning and Surgical Guides", then choose "One or 
Two Implant Case". 

 
 

 

 
 
If you have already opened some project, you can also press “Start Wizard” button in the top left 
corner. 
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The notification pops up, if you wish to start the new case, or open the Wizard with existing case. 

 
 

 
 
You can move between individual Wizard steps using the “Next” (1) and “Previous” (2) buttons. Every 
step clearly shows the Wizard stage you are in (3). There are thematic learning videos available for 
some of the activities (4). Whilst running the Wizard you can use the “Save Screenshot” (5) button and 
continue working with the screenshots via the “Screenshot Panel”. The button in the top bar is used for 
reactivating or restarting the currently used tool (6). 

 
If you find that the case requires more complex processing you can switch the Wizard off at any time 
and continue work in the Normal Mode (7). Any nerves that have been detected, implants inserted or 
guides created will be saved. 

 
The Blue Skype Plan Wizard may also be used as a tutorial. The menu selection “File > Learn Blue 
Skype Plan” opens a special dialog allowing source data to be uploaded to the model case. The model 
case is further analyzed in the learning videos available for every program step. 
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The Wizard allows planning to be done on the basis of various types of input data (Import Type): 
 

• DICOM + STL Model (Model STL) 
 
• DICOM + Model Scan (Model CT) 

 
• DICOM + Impression Scan (Impression CT) 

 
• DICOM + Impression Scan with Markers (Impression CT With Markers) 

 
 

22.1 Load DICOM data 
 
After starting the Wizard a dialog will open where you can select the import type, kit type and, after 
selecting some kind of kit types, the handpiece you want to use (1). 
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The following windows serve for DICOM data upload, potential dataset selection and to select volume of 
interest (2). If you have already uploaded some DICOM data when you started the Wizard, you will work 
with these data. The window “Load DICOM Data” will not open and the Wizard will move directly to the 
next step. 
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22.2 Adding a mandibular canal 
 
In this step, automatic nerve detection is carried out for both foramens. It is possible to cancel nerve 
detection if the user wants to work with the maxilla; in this case, click on “Cancel, it’s maxilla”. 

 
Automatic nerve detection for both foramens can be disabled in Preferences -> Advanced. 
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If this option is chosen, the user sets the foramens manually. Select “Set Right Foramen Manually” 
and in the 3D view click the cross-shaped cursor first on the right and then on the left mental foramen 
by selecting “Set Left Foramen Manually” (1). The mandibular canal is automatically detected (2) and 
its shape may be edited manually in any view except for 3D (3). If you do not need to detect the 
mandibular nerve, you can skip this step using the “Next” button. If you are working with the maxilla, 
click directly on the “Maxilla” button in the top bar. 
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22.3 Model upload and preparation 
 
In the next step the model will be uploaded and prepared. Depending on the surface scan import type, 
several preparatory steps can be run before a model is prepared for aligning with the DICOM data. 

 
• Model STL - simply upload. 

 
• Model CT - it is necessary to set the surface threshold and create a surface model. 

 
• Impression CT - it is necessary to first set the surface threshold and create an impression model. It is 
then necessary to plot and edit a curve in the impression model delimiting the appropriate model 
part and create an inverted model. 

 
• Impression CT with Markers – you need to align the scan appliance with the gutta percha markers 
(refer to section 7) and then, as in the case of the Impression CT, create an inverted model. 

 
 

22.4 Model aligning 
 
Except for the impression CT with Markers process, it is necessary to align STL model to CT dataset. 
After importing the model, select if the model is mandible or maxilla. The process of alignment will 
perform automatically after that. The same function of automatic alignment has the button "Automatic 
Model Alignment". 
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It is also possible to align the model manually by clicking the button "Manual Alignment". At least five 
identical teeth must be marked in the model and in the panoramic image. Points should be placed in 
exactly the same position in both scans. In the next step you must confirm the alignment or return to the 
previous step to improve the point setting. 

 
 

 
For reversing the alignment, click on the button "Undo Alignment". 
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22.5 Crowns and implants 
 
Now you can add crowns and implants. You can choose from several teeth geometry sets and 
implants compatible with the kit type selected at the start of the Wizard. The crowns are added 
together with the selected implants and in this step, you can only move them jointly. 
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In the next step you can adjust the implant and the crown positions separately. Both steps also display 
validation information about the status of the individual implants. 

 
 

 

The  icon appears if an implant is evaluated as invalid. After double clicking on this icon the Implant 
Validation Panel will open with further information. 
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If you continue while the collision between Software Guide Tube and the model is detected, you can 
choose in this step if you resolve collisions immediately or leave it as it is. 

 
 

 
 

22.6 Surgical Guide 
 
Prior to fabrication of the surgical guide you must specify the part of the model to be covered. In the 
“Draw Guide Curve” step, first draw a curve around the area of interest (Shift + left click). The curve is 
drawn on the base model. By generating surgical guide, the undercuts are removed and newly- 
generated model does not have them. You can edit the curve by moving its individual points and when 
moving on to the next step, the surgical guide will be fabricated. In both the “Draw Guide Curve” step 
and “Create and Verify Surgical Guide” step, windows can be added by right clicking on the base 
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model and adjusted by manipulation widget. By clicking the buttons "Next" (in the "Draw Guide Curve" 
step) or "Recreate Guide with Windows" (in the "Create and Verify Surgical Guide" step), a surgical 
guide will be recreated with windows. 

 
 

 
 

22.7 Saving and ordering 
 
In the remaining Wizard steps, you first save the prepared project. The template created is exported 
and can be submitted via BioBigBox.com. Then the PDF report with basic information and screenshots 
is saved. The necessary parts can be ordered directly at http://www.blueskybio.com. Then you can 
continue with a new case or close the Wizard. 

http://www.blueskybio.com/


BS-LS-0161-en Rev 4 Blue Sky Plan® 106 2023-08  

23 Orthodontics Module 
 
Blue Sky Plan makes it possible to plan orthodontic treatments based on imported STL models of the 
jaw with teeth. All of the controls are available in the “Orthodontics” panel. 
The planning begins with an intro screen titled “ Orthodontics ”, where the user selects the type of 
planning – “ Aligners ” or “ Indirect Bonding Tray ”, which splits further into “Align Brackets to Teeth” 
and “Align Brackets to Wire”. 

 

 

The specific type of planning can’t be changed in an upcoming process. You can view the selected 
type of planning for your project in the top left corner of the 3D window where the patient data is 
shown. 
The functions for model preparation are identical in all types of planning. Specifically, this includes the 
steps for Loading the Input Model, Jaw Alignment, Teeth Segmentation and Model Trimming. 
The individual types of planning include: 
Aligners: Teeth Moving – Edit Steps – Add Buttons (optional) – Design Aligners or Aligner Trim Curve 
(optional) – Export 
IBT (Align Brackets to Teeth): Add Brackets – Prepare IBT – Export 
IBT (Align Brackets to Wire): Teeth Moving – Edit Steps – Add Brackets – Prepare IBT – Export 
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23.1 Loading the Input STL Model 
 
 
 
 

The planning starts by loading the STL jaw model using the 
menu selection “Import Models” and choosing the correct 
orientation. It is also possible to use the option “Import 
Patient CT Scan”, with the stepwise uploading of CT data 
and jaw models. The alignment of the STL model and the 
CT scan is done via “Matching Teeth”, and the STL model 
can then be further worked with. 
If the other jaw (the opposing arch) is available, it can be 
imported in this step. After its uploading, the function “Show 
Opposing Arch” is activated, permitting the user to show/ 
hide this other model together with the “Collisions” function, 
switching on the colour visualization of collisions as the 
teeth approach each other or collide. 
Both jaws may already be aligned, or it is possible to 

activate the model alignment widget  to allow the user to 
move the jaw manually in the 3D view. Another available 
function for this purpose is “buccal bite registration” (see 
chapter 14.2). 

 
 
 
 
 
 
Blue Sky Plan also permits the processing and planning of both jaws in a single case. This requires 
uploading and aligning both models in the import stage. This step further includes the entry of the 
patient’s name, and for the next step you can proceed by clicking the “Continue to Jaw Alignment” 
button. 

 
 

23.2 Buccal Bite Registration 
 
Blue Sky Plan allows for upper-lower jaw alignment using a “buccal bite” surface scan. This process 
requires both jaw models to be imported. Then, the “Buccal Bite Registration” button can be used for 
transferring to the special “Buccal Bite Registration” panel. The maxilla and the mandible are already 
automatically uploaded to the panel and it is only required to add one or more buccal bite scans. The 
software then automatically aligns the maxilla and the mandible. Additional buccal bite alignments can 
be created (according to the number of the buccal bite scans) and visualization is possible for the 
mandible moving from the normal to each of the additional buccal bite alignments. 
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23.3 Mandible articulation 
 
The lower jaw articulation can be visualised by adding jaw articulator. This functionality is not 
dependent on import of the buccal bite and is available in all types of planning and all their steps on 
Buccal Bite Registration panel. Collisions between the upper and the lower jaw can be shown in all 
positions. 
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23.4 Annotating Teeth and Jaw Alignment 
 
23.4.1 Manual Teeth Annotation 

 
Once the jaw model is imported, it is necessary to mark all teeth, including those teeth that will not be 
moved or teeth that are missing. The teeth annotation is only possible when the “Mark Teeth Manually” 
button is active. 

 

 
The tooth from which the teeth marking starts is highlighted in red in the schematic jaw figure in the 
panel. First, the teeth on the patient’s right-hand side are annotated starting from the incisor and 
finishing with the molars. To mark a present tooth that will be moved, hold the “Shift” key and left click 
on the tooth. Orange and yellow dots illustrate the annotated teeth on the 3D model. A tooth that will 
not be moved, or is missing, should be marked by right clicking on the mouse (blue dots appears on 
the model). 
Once all the teeth on the first side are annotated, you can proceed with the other side by clicking “Go 
to Left Side” starting from the incisor highlighted in red again. 
It is not necessary to annotate all the teeth on each side. If the last molar, or so, is not present, you 
can skip marking the remaining teeth on the side by clicking either “Go to Left Side” or “Finish Teeth 
Marking”. 
While marking the teeth, it is possible to return one step back (the “One Tooth Back” button) and 
repeat the marking of the previous tooth, or to start from the beginning again by pressing “Clear All 
Teeth”. The colored (blue and yellow) labels indicate the teeth names. 
To complete the step, click the “Finish Marking Teeth” button. 

 
Note: The proper marking of the teeth is crucial for the subsequent automatic teeth segmentation step. 
It heavily impacts the precision of the segmentation. Incisors and canines should be marked by 
clicking/placing two dots on the occlusal edge of each tooth. Molars and premolars should be marked 
by placing the dots on the buccal side of the tooth surface as indicated in the image above. 

 
23.4.2 Automatic Teeth Annotation 

 
Blue Sky Plan allows the user to automatically annotate the teeth. To disable or enable this function go 
to Tools -> Preferences -> Orthodontics -> Automatic Annotation. 



BS-LS-0161-en Rev 4 Blue Sky Plan® 110 2023-08  

 
 
This functionality works exactly the same as manual annotation. User is able to switch between 
manual and automatic annotation for manual modifications of the dots. To complete the step, click the 
“Finish Marking Teeth” button. 

 
If the input STL model was obtained by 3D scanning, it can be closed and repaired by clicking the 
“Close Model” button. The thickness of the final stone model, i.e. the minimal allowed height in 
millimetres, is at least 20 mm and can be increased in Preferences. 

 

 
 

23.5 Two Jaw Functionality 
 
Once the teeth of the first jaw (maxilla) are annotated and the model is closed, the transfer to the 
mode of planning both jaws is activated. By default, the workflow is set so that after clicking “Continue 
with Mandible” a direct transfer is performed to the second jaw annotation. To plan both jaws, both 
models must be annotated and aligned. In the following steps there is the option to actively work with 
one or the other jaw. If the dentist uses the other model (the opposing arch) for visual control in the 
course of the planning step and for the depiction of possible inter-mandibular collisions only, the “Skip 
this Jaw” button can be used for direct transfer to a single jaw segmentation. 



BS-LS-0161-en Rev 4 Blue Sky Plan® 111 2023-08  

23.6 Teeth Segmentation 
 
The transfer to the step of the automatic segmentation of individual teeth may take a while as the 
program tries to identify the gingival margin automatically. 

 

 
 
 
 

After the automatic segmentation, you can adjust the 
detected gingival margin of the active/selected tooth by 
dragging the control points of the curve, or by manually 
drawing a part of the curve on the model while holding down 
the “Shift” key and left mouse button simultaneously. 

 
 
 
 
 
The gingival margin can be edited for the active tooth only. The active tooth can be changed 
throughout the schematic jaw image in the panel, or by clicking the segmented tooth directly in the 3D 
view. 
Once the boundaries need no further refinement, you can finish the segmentation by clicking the 
“Continue to Model Trimming” button. This applies the changes made and separates the teeth from the 
3D scan being able to move them. 

 
 
23.7 Model Trimming 

 
The STL model imported to BSP may contain excess material and printing it would mean an 
unnecessary waste of printing material. For these situations, BSP offers the trimming function by 
means of a curve. The trimming curve is created automatically at a distance from the teeth based on 
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the “ Gingiva Trim Margin ” parameter (which can be modified in Preferences). The curve is further 
manually adjustable by dragging the control points. 
Part of this step is also the closure and trimming of the model at a specific height based on the 
distance of the segmented teeth. The parameters “Model Height Below Mandible Teeth After 
Trimming” for the lower jaw and “Model Height Above Maxillary Teeth After Trimming ” for the upper 
jaw can be modified in Preferences. The Model Trimming step can be skipped by using the options 
“Don’t Trim Maxilla” or “Don’t Trim Mandible”. 

 

In this step, Model Trimming is only defined. It will only start after clicking on Continue to Teeth Moving, 
so this operation may take a while. 

 
 
 

After the separation of the teeth, the gingiva may be 
augmented (i.e. inflated) to prevent interference with the 
aligner and to help prevent tissue impingement. Note: Due 
to the optimisation in the processes, the .0mm value is 
recommended for versions 4.7.50 and higher. The .2mm is 
recommended for versions 4.7.20 and older. This is the 
“Gingiva Augmentation Amount” parameter in Preferences. 

 
 
 
Also, the colours of the 3D model and the teeth change to a more natural pink and white, respectively. 
Now the software allows you to reposition the teeth and plan their final positions. 

 
23.8 Teeth Moving 

 
In this step, the target positions of individual teeth can be planned. You should start by selecting the 
active tooth – either by left clicking on a tooth in the schematic jaw image in the panel, or by clicking 
the tooth in the 3D view. 
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The active tooth has a visible tooth midline and a 3D 
manipulation widget shown around it. Using the widget, you 
can move and rotate the tooth in the following types of 
movements: 

• Mesial / Distal tipping 
 

• Buccal / Lingual tipping 
 

• Rotation along longitudinal tooth axis 
 

• Intrusion / Extrusion 
 

• Left / Right 
 

• Forward / Backward 
 

A couple of interesting functions can be activated in the 
orthodontic panel after this step. The “IPR” option will show 
a 3D view of the sizes of the over-limit Interproximal 
reductions, and the limits of the maximum allowed IPR can 
be set in Preferences. The red areas informatively visualise 
inter-teeth collisions. “Diastemata” shows the measurement 
of the space between the teeth. “Initial position” shows the 
original model before the teeth positioning. 

 
 

The "Snap to Curve" section allows the user to adjust a 
curve representing an ideal teeth arch and snap one or all 
teeth to this curve. By clicking on "Edit Curve" the user edits 
the curve points symmetrically or asymmetrically. The 
"Reset Curve" button resets the curve to its original position. 
If the user clicks on the "Edit Curve" button again, the curve 
can no longer be edited. 

 
Every tooth can be locked in position by right clicking on the 
tooth or the button “Lock Tooth”. Unlocking proceeds 
similarly or the user can unlock all teeth at once. 
It is possible to change the point of rotation of 3D 
manipulation widget, i.e. to switch between the tipping and 
torque. The tipping and torque angles are tracked and 
reported separately. Pivot offsets can be set in Preferences. 
The user can also adjust the midline when the “Refine 
Midline” button is active. 
The “Reset Tooth” button cancels all the adjustments made 
and returns the active tooth to its original position. The 
“Reset All Teeth” button returns all the teeth to their original 
positions. As the active tooth is being moved, the 
“Orthodontics” panel shows information about the total 
movements in the form of distances [mm] and angles [°] 
from the initial position. Movement limits can be set as 
monthly, bi-weekly or weekly. 
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When positioning a tooth, it is sometimes useful to see the 
movement of the whole tooth, including its roots. Therefore, 
Blue Sky Plan allows you to add a virtual tooth with roots 
simply by enabling the checkbox “Show Virtual Tooth”. To 
refine the shape and position of the newly added virtual 
tooth so it closely matches the underlying tooth separated 
from the 3D scan, click the tooth (it turns red) and enable 
the “Adjust Virtual Tooth Position” button. Now, you may 
adjust the position and size of the virtual tooth using the in- 
scene widget. For better clarity of the roots, you can 
increase the transparency of the jaw by moving the slider in 
the panel. To hide the virtual teeth, click on the "Hide All 
Virtual Teeth" button. 

 
 
 
 
 
 
 
 
 
 

To work with a selected tooth, right click on the tooth and 
choose the functionality. To hide the tooth, select "Hide 
virtual tooth". To reset the tooth to its original position, select 
"Reset virtual tooth position". 

 
 
 
 
 
 
 
 
 
 
 
 

When positioning a tooth, it is sometimes useful to see the 
movement of the whole tooth, including its roots. Therefore, 
Blue Sky Plan allows you to add segmented teeth with 
roots. To work with CT Teeth, go to Preferences -> 
Orthodontics -> Segment CT Teeth -> enabled. This option 
must be enabled during the import step in order to work 
with segment CT teeth! 
To see segmented CT teeth, click on the "Show CT Teeth" 
button. To hide all the visible CT teeth simply click on the 
"Hide All CT Teeth" button. For better clarity of the roots, you 
can increase the transparency of the jaw by moving the 
slider in the panel. To work with a selected tooth, right click 
on the tooth and choose the functionality. To hide the tooth, 
select "Hide virtual tooth". 
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23.9 Generating Intermediate Positions 
 
Once you are satisfied with the target positions of the teeth, use the “Continue to Edit Steps” button to 
generate intermediate positions and move to the next planning step. 
The table in the “Orthodontics” panel lists the number of necessary intermediate steps to reach the 
planned target position of the active tooth. The number of steps is always the same for all the teeth, 
but it is possible to start the movement of teeth in later steps. The first and last row in the table 
represent the initial and target position of the active tooth, so these positions are locked and cannot be 
changed at this planning stage. The number of steps is estimated automatically based on the pre- 
defined settings of maximum movement limitations. The default movement limitations are stored in the 
application Preferences and can be adjusted manually. 

 
 

The slider at the top of the “Orthodontics” panel allows you to move 
teeth over time and in intermediate steps. If the slider is moved to the 
left, the teeth are visualised at the initial positions. The very right 
position of the slider represents the planned target positions. By 
dragging the slider, you can animate the movement of the teeth 
through intermediate steps over time. Further, you can move the slider 
to one of the interim steps and, if needed, adjust the position of the 
active tooth in this concrete step to prevent collisions with its 
neighbouring teeth. 
In the table, there are two columns of checkboxes. It may be important 
to start the movement of the active tooth later in a step. The starting 
step can be changed by checking the checkbox in the left column. 
After any change, it is necessary to regenerate the entire table by 
clicking the button “Refresh Steps”. The checkboxes in the right 
column can be used to lock the intermediate positions of the tooth – 
the tooth always moves through the locked intermediate positions. 
Two optional plans are available – “Least movement move last” and 
“Least movement move first” for organising teeth movement. 

 
 

In the Aligners planning type, it is necessary, at the end of this step, to select which method of creating 
aligners will be used further on. For the generation and export of model intermediate positions only, 
the default selection “ Export Models Only ” is sufficient. 
By selecting the “ Design Printable Aligners ” option, the aligners will be drawn and generated directly 
as models in BSP, which can later be exported. Selecting “ Design Aligner Trim Curve ” means that the 
trimline, applicable to the mining machine, will be drawn on the models and exported. It’s very helpful 
for automatic aligner trimming. 
If buttons are meant to be added on model intermediate positions, it is necessary to check the “Add 
Buttons” as well. Doing that will add this step to the rest of the process. 

 
 
23.10 Orthodontic Aligners 

 
The method of creating aligners can be selected at the end of the step “Generating the intermediate 
positions” (described in the previous chapter). The upcoming steps will be based on this selection. 
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23.10.1 Add Buttons 
 
Buttons are added automatically through the predefined “Automatic Button Placement” in Preferences. 
Buttons are placed according to the clinician’s instructions. Buttons can be added manually after right 
clicking on the tooth in the 3D view and selecting among several sets, shapes, and sizes. The button 
position can be fine-tuned manually. 

 

 
 

23.10.2 Design Printable Aligners 
 
This step is intended to be used for drawing and editing the curve for the aligner fabrication. The 
aligner curve will be generated automatically based on the settings of the “Curve Shape” and “Trim 
Margin” parameters in Preferences. Both parameters can be adjusted as well and regenerate directly 
on the Orthodontics panel. These changes are saved in the project. If the parameters are changed in 
this process, it is necessary to regenerate the curve by clicking the “Reset Curve” button. The 
generation of aligners is a part of the transition to the STL model export step. 

 

 

The production of aligners may be ordered at Blue Sky Bio. You must send the STL files containing the 
models with the 3D profile on them to identify the patient and stage number to Blue Sky Bio. Blue Sky 
Bio will make the aligners and ship them to you. If at any stage the patient no longer matches your 
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model for that stage (making the aligner not fit) then edit the models and re-order the aligners. More 
detailed instructions for use are available in Footnotes 21.1 

 
 

23.10.3 Design Aligners Trim Curve 
 
The Aligner Trim Curve will be (just like the Aligner Curve) generated automatically based on the 
settings of the parameters “Curve Shape” and “Trim Margin” in Preferences. Both parameters can be 
adjusted as well and regenerate directly on the Orthodontics panel. These changes are saved in the 
project. If the parameters are changed in this process, it is necessary to regenerate the curve by 
clicking the “Reset Aligner Trim Curve” button. To use the trimline information for the automatic 
trimming of the aligners in the milling machines’ information in the future, it is possible to turn on “Show 
locator” and modify the trim curve accordingly. It will be possible to export the curve in the last step. 

 

 
 
The type of the aligner locator model can be set in the Preferences -> Orthodontics -> Aligners 
section. The locator type can be changed in the Export step as well. 

 

 
 

23.11 Indirect Bonding Tray - Align Brackets to Teeth 
 
Blue Sky Plan also allows for controlled virtual bracket placement in the software and the fabrication of 
an indirect bonding tray to allow the physical brackets to be placed. 
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This planning type is used to add brackets to the initial position of the teeth. That is the reason why it 
doesn’t include the Teeth Moving step and after Model Trimming goes straight to Add Brackets. 

 
 

23.11.1 Add Brackets 
 
Brackets are added directly on the teeth based on the predefined “Brackets Placement Offsets” in 
Preferences. The position of already added brackets can be modified by the 3D manipulation widget 
and the function “Snap to Tooth” by right clicking with the mouse. 

 

Brackets from several systems are available. 
 

 
 

23.11.2 Prepare IBT 
 
Once the brackets are placed, the next step will include drawing and editing the curve for indirect 
bonding tray fabrication. Its use allows the physical brackets to be placed accurately in real life. 
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23.12 Indirect Bonding Tray - Align Brackets to Wire 
 
23.12.1 Add Brackets 

 
The “Align Brackets to Wire” planning type is used to add brackets to the final position of the teeth. 
Blue Sky Plan automatically places the brackets along the wire. The brackets fully respect the 
rectangular wire and do not adjust their position according to the teeth surface. Just as in the previous 
method, it is possible to choose from several bracket systems and the added bracket can be modified 
using the 3D manipulation widget and function Snap to Wire by right clicking with the mouse. 
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23.12.2 Prepare IBT 
 
This step includes drawing and editing the curve for indirect bonding tray fabrication similarly to the 
previous type of planning. The curve is drawn on the final position of teeth. The indirect bonding tray is 
generated for the first position model only. The default setting for IBT fabrication can be changed in 
Preferences. 

 
23.13 Generating and Exporting STL Models 

 
The final step, Export, is again common for all types of planning. The only difference is in what can be 
exported in this final step (OBJ or STL models or the parameters of the curve). 

 

 

Before the export itself, it is necessary to check all of the intermediate positions of the generated 
models. 
Platforms are automatically added to the generated models, allowing for the horizontal 3D printing of a 
larger number of models. They are added separately for models and for aligners, and for additional 
work with them, it is necessary to have the correct option checked on the Orthodontics Panel. The 
default settings for platforms (size and rotation) are found in Preferences, Orthodontics tab. These 
parameters can be further manually adjusted for a specific case. Using the “Separate” slider, it is 
possible to create two smaller parts at the end of the jaw, which are sufficient for printing. You can add 
the platform to a model just in one step – it will be generated in the remaining steps. 
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The Orthodontics panel also allows you to supplement the generated intermediate models and 
aligners or IBTs with text with a 3D profile emboss or engrave (typically the patient’s name and the 
step number). This is done with the “Label Tool” which works like the one used to emboss text on 
surgical guides. The text needs to be attached to the first model only and it is automatically 
propagated onto the other intermediate models. It is necessary to choose either the emboss or 
engrave method in the “Label tool” and if it will be applied on the generated models or aligners (IBT). It 
is also possible to choose if the label text and number of the model will be generated on the same row. 

 

If the generated STL model should be optimised for print, hollow with (or without) a cross pattern, 
the user must check the "Generate Steps as Hollow Models" and “Generate Cross Pattern” in 
Preferences, in the Orthodontics tab, before exporting. 

 

 
Besides the models, the parameters of the Aligner Trim Curve can be exported as well for the Aligners 
planning type. The generated curves for intermediate models can be modified individually with the 
visualised locator to be optimally prepared for use on the milling machines. The parameters “Curve 
File Delimiter” and “Curve File Extension” can be modified in Preferences. 
The generated models can be exported from the software in the form of STL models by pressing the 
“Export” button. 



BS-LS-0161-en Rev 4 Blue Sky Plan® 122 2023-08  

Note: To export the STL files, you must have a valid STL export license! 
For immediate and automatic STL license activation, purchase exports directly in the Blue Sky Plan 
Software (File > Purchase STL Exports). You may also purchase STL case exports from https:// 
blueskybio.com/store/stl-case-export. 
Finally, it is also possible to generate the so-called Tooth Movement Report with the angles and 
displacements of the teeth moved from the original position to the final position. In addition, the report 
shows the movements from each intermediate position to the next stage. 

 
 
23.14 Quick Instructions for Using the Computerised 
Orthodontic Bracket System 

 
More detailed instructions for use are available in Footnotes 21.2 
The user during the export step should select the check boxes for “Export models” and “With Brackets” 
and generate a model, including the bracket location indicators, in the form of an STL model. 

 
23.14.1 Printing the Model 

 
The user should use a relevant 3D printer that prints at a resolution of at least 150 microns on the x/y 
axis and 100microns on the z axis, to print the exported model in grey or tan model material. The 
printer control software, printer and model material should be labelled for use together. 
Select the exported STL model file in the printer control software for printing. 

 
23.14.2 Adding Brackets 

 
Use cement to firmly secure the desired brackets to the bracket location markers on the 3D printed 
model. 

 
23.14.3 Creating the Indirect Bonding Tray by Pressure Forming 

 
The user creates the Indirect Bonding Tray by pressure thermoforming over the 3D printed model with 
brackets attached to an outer carrying shell from a legally marketed orthodontic resin such as Essix 
Ace. The user should then trim the shell to the middle of the brackets for easy release. 
The brackets should then be placed into wells created in the shell. Skip to section 1.9 using the 
indirect bonding tray to place the brackets. 

 
23.14.4 Creating the Indirect Bonding Tray by Printing (this method should 
only utilised in an FDA registered establishment) 

 
The user should click “Create the indirect bonding tray”. 
The user should check the print screen image of the tray for accuracy, and when it is correct export/ 
print the indirect bonding tray by choosing File>Export Data and selecting the indirect bonding tray to 
be exported as an STL. 
The user should use a relevant 3D printer that prints at a resolution of at least 150 microns on the x/y 
axis and 100microns on the z axis, to print the exported model in grey or tan model material. The 
printer control software, printer and model material should be labelled for use together. The material 
should be a light cured resin which is not recycled or recyclable. 

https://blueskybio.com/store/stl-case-export
https://blueskybio.com/store/stl-case-export
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Select the indirect bonding tray STL file in the printer control software to be printed in the legally 
marketed impression tray resin material called NextDent Ortho IBT. 
Brackets should then be placed into wells created in the shell of the printed indirect bonding tray. 

 
23.14.5 Using the Indirect Bonding Tray to Place the Brackets 

 
The user should place the brackets onto the teeth by placing conventional cement onto the bracket 
pads following the manufacturer’s instructions and seat the tray with the brackets into the patient’s 
mouth. Excess cement should be removed, and a light cure should be used via the Indirect Bonding 
Tray. 
The outer carrying tray should be removed and the inner liner tray should be peeled off. Excess cured 
cement should be removed. 

 
23.14.6 Use of the Blue Sky Plan Calibration Verification STL file 

 
The calibration of the printer should be done according to the printer manufacturer’s instructions and in 
accordance with the quality system of the FDA registered establishment printing the trays. The 
frequency of calibration should be determined by the printer manufacturer’s printer instructions and the 
establishment’s quality system. Blue Sky Bio provides a calibration verification file to confirm adequate 
calibration. Calibration verification should be done whenever the printer is calibrated and any time the 
printing material is changed. 

• 
Download the calibration verification STL file from the Blue Sky Bio website 
• Import the STL calibration verification file into the printer control software 
• Print the STL file 
• Measure each cube in all 3 dimensions and the distances between adjacent cubes with calliper. 
The size of each cube is printed on the cube. 
The distance between cubes is 3mm. 
The measurements of the cubes and open spaces should be within the certified accuracy of the 
printer. 
If the measurements fall outside that range, recalibrate the printer according to the printer 
manufacturer’s instructions. 
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Precautions: Do not touch the bonding surfaces with your bare fingers as skin oils may diminish the 
adhesion. Do not allow adhesive to get under the bracket in the guide slot. The position of each 
bracket should be verified by the clinician and if necessary malpositioned brackets should be removed 
and repositioned. Ceramic brackets may abrade the opposing arch. Wait to apply the ceramic brackets 
until the bite has opened. If necessary, use metal brackets before the placement of ceramic brackets. 
Provide the patient with instructions on how to conduct thorough oral hygiene, as tartar or food debris 
may impair the function of the bracket. Do not apply excessive force when opening the bracket as the 
bracket may bend or detach from the tooth. To prevent splintering when removing the brackets, use 
the appropriate instrument. If patient experiences an allergic reaction, immediately remove the bracket 
and advise patient to seek medical care. 

 

24 Denture module 
 
Blue Sky Plan permits the user to model and export dentures. The functions are available in the 
“Denture” panel once the user switches to the “Denture” module. 

 

24.1 Loading the patient’s STL model 
 
New planning starts by loading the STL jaw impression model using the main module selection 
“Dentures > Import Models”. To start planning the denture, the user needs to switch to the “Denture” 
module from “Model Manipulation”. 

 
24.2 Adding virtual teeth 

 
Virtual teeth can be added by clicking on the  icon in the toolbar. A dialog for selecting crown(s) 
then opens. Clicking on a tooth selects it, and a text description of the crown appears below the 
preview. Multiple teeth can be selected by holding down the Shift or Ctrl key. Another possibility is 
clicking on Select All Maxillary Teeth/Select All Mandibular Teeth or Select All Teeth. It is also possible 
to select from three sizes. Teeth are added as teeth chain. We confirm the selection by clicking the 
“OK” button; the "Cancel" button closes the dialog without making a selection. 
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Virtual teeth are regular teeth sets, available in Surgical Guide, Denture, and Crown and bridge, 
modifiable and exportable. Physical teeth are for Denture creation, cannot be modified and exported. 
Can be bought from the future parts panel. 
The Denture Panel is used for denture modelling. After clicking on the “Denture Panel” tab, the below 
menu will appear with buttons for working with the teeth chain. 

 
 
 

24.3 Mark visible teeth for teeth chain 
 
 
 
 

Clicking on “Mark Visible Teeth for Teeth Chain” 
and using the control allows for the manipulation of 
the teeth chain. The teeth can also be moved 
individually with the arrows to different sides. 
Rotation is done by using the circles surrounding 
the teeth chain. Each axis is represented by one 
colour. 

 
 
 
 
 
 
 

24.4 Clear Teeth Chain 
 
Clears selected teeth chain. 
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24.5 Show / Hide teeth chain 

 
 
 
The button “Show / Hide Teeth Chain” is used for showing and hiding the green dot indicators in the 
teeth chain. There is one indicator per tooth. 

 
 
24.6 Move Entire Teeth Chain 
 

“Move Entire Teeth Chain” permits the user to hide 
teeth chains in the maxilla or the mandible by 
selecting the appropriate option. 
The scale is used to enlarge or diminish the teeth. 

 
 
 
24.7 Manipulate model 

 
The model can be unlocked by clicking the checkbox and the centre of rotation can be changed. 

 

 
 
 
 
 
 
 
 
 
 
 

24.8 Create denture 
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A denture can be created in the menu in the right panel. This requires selecting a file, the correct jaw 
orientation, and confirming by clicking “Create Denture”. 

 
 
 
 
 
 

 
 
 
 

24.9 Step 1 – Undercuts and insert direction 
 
Step 1 is used to define the initial parameters for the denture. 

 
 
 

 
 
The sliders can be used for setting the values for offset and undercut removal. 
The insert direction should be adjusted using the rotation ring so that the undercuts 
are minimised. 
“Set insert direction from view” is used to set the insert direction according to the 
current viewing angle setting. 
“Reset insert direction” will restore the original status of the arrow and the model. 

 
 
 
 

“Define posterior palatal seal” permits the 
modelling of this structure. The Palatal Seal is 
created by left clicking with the mouse on the two 
required points with Shift key pressed. 
Adjustments can be done by drawing with the 
mouse. 

 
 
 
 
 
 
The “Back” and “Next” buttons are used for moving one step back or forwards. 
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24.10 Step 2 – Select denture base 
 
Step 2 defines a contour around the teeth chain to define the borders of the denture. If a contour is not 
defined, user is not able to get to another step. 

 
 

 
 

The offset from the gingiva and thickness of the denture can be set by the sliders. 
Gingiva extension allows the user to extend the gingiva with the slider. The thickness and smoothness 
from the gingiva can be set with the sliders. 
Pressing the Shift key and double clicking on the model around the teeth will add new points and 
create a blue contour around the area representing the denture base: 
The contour can be deleted by selecting “Clear 
contour”. 

 

24.11 Step 3 – Shape gingiva 
 
Step 3 is used for adjusting the created gingiva. 

 
 

 

The following adjustments can be made within this step 
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Add/remove – addition/removal of gingiva material 
Smooth – gingiva surface smoothing 
Local deform – creation of ups and downs 
Show Teeth Chain – display of the green dot indicators 
Move Entire Teeth Chain – manipulation with the teeth chain 

 

 

The “Tool size” slider is used for tool size selection, and “Tool strength” defines the strength of the tool. 
The original values can be restored by selecting the “Set to Default” button. 

 
24.12 Step 4 – Denture 
Step 4 is used for finalizing the denture creation. During this step, virtual teeth penetrating through the 
denture base are reduced while maintaining the minimum denture thickness. 

 
 

 
Sliders are used for selecting Teeth offset and Min denture thickness. 
Tooth reduction coping generates denture cop primarily for physical teeth followed by cutting in the 
laboratory. Connect Teeth as single STL file makes the work easier for the export. 
The model design is completed by selecting the “Next” button. 
 

24.13 Export 
The user can export created denture in this step. Quality of the export can be set as well as swap face 
orientation. Export separated files exports selected objects to a separated file or one single file created by 
the user. 
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24.14 Teeth Surfaces panel 
 
Teeth Surfaces lists the imported patient’s STL models, placed virtual teeth and their reduced versions, 
and the newly generated denture base: 

 

The table includes the following attributes: 
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“Lock” – surface locking controlled by a checkbox 
“Name” – surface name 
“Closeness” – surface closeness controlled by a checkbox 
“Visible” – surface visibility or hiding by a checkbox 
“Colour” – surface colour 

 - surface removal 

 
Filters can be used to display either the maxilla or 
the mandible only or selected object types: 

 
 
 

24.15 Opening saved project 
 
A saved case is opened with “File > Open Project…” in the top left corner. 

 

After clicking, the file to open is selected and the selection is confirmed with “OK”. 
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The selected project opens. 
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24.16 Screenshots 
 
The Screenshot panel can be used for taking a screenshot with the  button located in the top right 
corner of the workspace. 

After clicking the button, the “Save screenshot” message appears, and the screenshot is included in 
the column in the right panel. 

 

 
The arrows on the right are used for changing the screenshot size. 

 

 
Video allows the exporting of the screenshots as AVI video or animated gif with custom text and 
selected font size and type. 
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25 Crown and Bridge module 
 
Blue Sky Plan allows the user to create a bridge and crowns and change the geometry of the virtual 
teeth. These functions are available in the "Crown and Bridge" panel once the user switches to the 
Crown and Bridge module. 

 
 
25.1 Loading the patient’s STL model 

 
The new planning starts by loading the STL jaw impression model using the main module selection 
“Crown and Bridge > Conventional Crown | Crown for Titanium Base | Bridge”. To start planning the 
crown and bridge, the user needs to switch to the “Crown and Bridge” module from “Model Editing”. 

 
 
25.2 Adding virtual teeth 

 
Virtual teeth can be added by clicking on the  icon in the panel list “Virtual Teeth > Add Tooth”. A 
dialog for selecting the crown(s) then opens. Clicking on a tooth selects it, and a text description of the 
crown appears below the preview. Multiple teeth can be selected by holding down the Shift or Ctrl key. 
Another possibility is clicking on Select All Maxillary Teeth/Select All Mandibular Teeth or Select All 
Teeth. It is also possible to select from three sizes. Teeth are added as a teeth chain. 
By clicking the “OK” button, the selection is confirmed; the “Cancel” button closes the dialog without 
making a selection. 

 

 

Virtual teeth are regular teeth sets, available in the Surgical Guide, Crown and Bridge and Denture 
module, are modifiable and exportable. 
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25.3 Restoration Design panel 
 
The Restoration Design panel allows the user to choose the restoration type – crown on a tibase and 
conventional crown. It is also possible to select the jaw type and antagonist model as well as to create 
a bridge. 
The antagonist model resolves and detects a teeth collision. If there is only one jaw available, the “no 
antagonist” selection resolves this situation. 

 

 

The tibase can be chosen by clicking on the tooth or by clicking on the tibase dropdown. If a tibase is 
not selected, the user cannot go further. 

 
 
25.4 Restoration type selection – Crown on a Tibase 

 
The Crown on a Tibase selection can be chosen in the menu in the right panel. This requires the 
selection of a restoration type, jaw, model, crown, tibase, and antagonist model (optional) (if a user 
uses maxilla and mandible) and confirming by clicking “Start”. 

 

 

Step 1 – Undercuts 
Step 1 is used to define the initial parameters for the crown. 



BS-LS-0161-en Rev 4 Blue Sky Plan® 136 2023-08  

 
 
 

The slider can be used for setting the values for the undercut. 
“Set insert direction from view” is used to set the insert direction according to the 
current viewing angle in the 3D view. 
“Reset insert direction” restores the original setting of the insert direction. 
The “Back” and “Next” buttons are used for moving one step back or forwards in the 
design flow. 

 
Step 2 – Define approximal area 
Step 2 is used to select/colour the existing adjacent teeth so the crown can be resized by the software 
to fit. 

 
 

 
 
The approximal area can be deleted by selecting “Clear Area”. Pressing the Shift key and holding the 
left mouse button will define the approximal area and create a brown contour around the selection 
representing the crown and bridge base. 

 
By pressing the Ctrl key and left clicking with the mouse, you can remove the selection. The “Tool size” 
slider is used for brush size selection. 
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Step 3 – Margin detection 
Step 3 detects the tooth margins used for crown creation. Pressing the Shift key and holding the left 
mouse button allows the margin to be edited. 

 

 
 
The Project Margin button projects the curve defined by the user on the deformed tooth. 

 
 

 
 
 
Step 4 – Tibase editing 

 

Step 4 is used for crown upgrading and the creation of a crown screw channel. 
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“Crown margin” can be used for setting the crown margin. 
“Titanium base margin” can be used for setting the base margin. 
“Crown cement spacer” is an extra space for the glue between the crown and abutment. 
The create crown screw button creates a hole going through the crown so that the user can access the 
abutment screw and screw the abutment into the implant. 

 
Step 5 – Crown editing 
Step 5 is used for adjusting the created crown. 

 

 
“Add/Remove” is used for the addition/removal of the crown material. 
“Smooth” smooth the crown surface. 
“Local deform” Tool that deforms the tooth at a local point. 
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The “Tool size” slider is used for tool size selection, and “Tool strength” defines the strength of the tool. 
The original values can be restored by clicking on the “Set to Default” button. 
The relevant checkbox can be used for hiding Cut Approximal Intersections and Cut Occlusal 
Intersection. 

 
25.5 Restoration type selection – Conventional crown 

 
Conventional crown selection can be chosen in the menu in the right panel. This requires selecting a 
restoration type, jaw, model and confirming by clicking “Start”. The crown and antagonist models are 
optional. If a user selects the (no crown) option, the crown is added in the third step. 
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Step 1 – Margin line definition 
Step 1 is used to define a closed margin line along the remaining tooth structure. The user is able to 
select between automatic margin line detection and manual mode. To work with automatic detection, 
click on “Automatic Margin Line Detection” radio button. Click 2 points (Shift + left click) as you can 
see in the picture below to detect a curve. Curve should be detected automatically. It is possible to 
move with points or add more points to more precise detection. 

 
 

 
 
To work with manual margin line, click on “Manual Mode” radio button. Click points (Shift + left 
click) along the remaining tooth structure. Closed curve can be modified by holding Shift and left 
mouse button. 

 
 

 
 
The margin can be deleted by selecting “Clear Area”. Undo and redo can be used as well for 
modifications 

 
Warning: A closed margin line has to be defined first to continue to next step! 
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Step 2 – Undercuts Step 
Step 2 is used to define the initial parameters for the crown. 

 

 
 
The slider can be used for setting the values for the undercut. 

“Set insert direction from view” is used to set the insert direction according to the 
current viewing angle in the 3D view. 
“Reset insert direction” restores the original insert direction. 

 
Step 3 – Define approximal area 
Step 3 is used to select/colour the existing adjacent teeth so the crown can be resized by the software 
to fit. 

 
 

 
 
 

The approximal area can be deleted by selecting “Clear Area”. Pressing the Shift key and holding the 
left mouse button will define the approximal area and create a brown contour around the selection 
representing the crown and bridge base. By pressing the Ctrl key and left clicking with the mouse, you 
can remove the selection. 
The “Tool size” slider is used for brush size selection. 

 
Step 4 – Crown bottom editing 
Step 4 is used for editing the crown bottom. 
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“Crown cement spacer” is an extra space for the glue between the crown and abutment. 
“No cement gap” allows the user to edit the crown margin. 
“Horizontal” defines the horizontal crown border width. 
“Angled” defines the length of the angled part of the border. 
“Angle” defines the angle of the angled part. 
“Vertical” defines an additional vertical border. 
“Minimal Thickness” is used to edit the minimal thickness. 
The relevant checkbox can be used to hide the minimal thickness. If the user selected the (no crown) 
option in the restoration panel, the “Add New Tooth” dialog is available to select the tooth by clicking 
on the “Next” button. Only one tooth can be selected. The tooth is added by clicking on the “OK” 
button. Cancel closes the “Add New Tooth” dialog. 

 
Step 5 – Tooth placement and editing 
Step 5 is used for tooth placement and tooth editing. 

 
 

 
 

“Transform” activates the widget for tooth placement. 
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“Add/Remove” is used for the addition/removal of the crown material. 
“Smooth” smooths the crown surface. 
“Local deform” allows the creation of ups and downs. 
The “Tool size” slider is used for tool size selection, and “Tool strength” defines the strength of the tool. 
The original values can be restored by clicking on the “Set to Default” button. 

 
Step 6 – Crown editing 
Step 6 is used for additional crown editing. 

 
 

 
 

“Add/Remove” is used for the addition/removal of the crown material. 
“Smooth” smooths the crown surface. 
“Local deform” Tool that deforms the tooth at a local point. 
The “Tool size” slider is used for tool size selection, and “Tool strength” defines the strength of the tool. 
The original values can be restored by clicking on the “Set to Default” button. 
The relevant checkbox can be used for hiding Cut Approximal Intersections and Cut Occlusal 
Intersection. 

 
25.6 Create Bridge 

 
The create bridge function is available in the Restoration Design Panel but only if you select Bridge 
process flow in the Main screen. It allows the user to design a bridge for missing teeth. By clicking on 
“Create Bridge”, the user starts a new process flow. 
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Step 1 – Unit Bridge 
Step 1 is used for setting the points between the teeth to unit them. If the teeth are intersecting, the 
blue points are not created. 

 

The blue points can be dragged along the teeth to set the bridge according to the user’s preferences. 
 
Step 2 – Editing connections 
The blue points allow the user to edit the connections between the crowns or teeth. 
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Step 3 – Bridge editing 
 
Step 3 is used for editing the bridge. 
 

 
 
 
“Add/Remove" is used for the addition/removal of the material. 
“Smooth” smooths the bridge surface. 
“Local deform” allows the creation of ups and downs. 
“Global deform” creates ups and downs on a global scale. 
The “Tool size” slider can be used to change the brush tool dimension, and “Tool strength” defines the 
strength of the tool. The original values can be restored by clicking on the “Set to Default” button. 
If the teeth are overlapping, the union operation between teeth is being performed and the first two 
steps are skipped. 

 

Step 4 – Undercuts 
Step 4 is used to define the initial parameters for the bridge. 
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The slider can be used for setting the values for undercut. 
“Set insert direction from view” is used to set the insert direction according to the 
current viewing angle in the 3D view. 
“Reset insert direction” restores the original insert direction. 
Bridge creation is finalized by clicking on the “Next” button. 

 

25.7 Teeth Surfaces panel 
 
Teeth Surfaces lists the imported patient’s STL models, placed virtual teeth and their reduced versions, 
and the newly generated crown base: 

 

The table includes the following attributes: 
“Lock” – surface locking controlled with a checkbox. 
“Name” – surface name. 
“Closeness” – surface closeness controlled with a checkbox. 
“Visible” – surface visibility or hiding with a checkbox. 
“Colour” – surface colour. 

 – surface removal. 
Filters can be used to display either the maxilla or the mandible only, or selected object types: 
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25.8 Teeth Edit panel 
 
The Teeth Edit panel allows the user to edit the shape of a tooth by using different editing tools: 

 

“Manipulate Model” allows the user to change the position of the tooth. 
“Smooth” smooths the tooth surface. 
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“Global Geometry Transform” creates ups and downs on a global scale. 
“Add/Remove” is used for the addition/removal of the material. 
“Local Geometry Transform” creates ups and downs on a local scale. 
“Relax Mesh” is similar to smoothing while it respects sharp edges to some degree. 
The “Tool size” slider can be used to change the brush tool size. The original values can be restored 
by clicking on the “Set to Default” button. 
Boolean operations allow the user to join and subtract 3D models. 
 

 

 
 

25.9 Parts panel 
 
The Parts Panel lists the imported patient’s drill kit and guide type and quantity of each part, which can 
be added to the shopping cart. 

 

The user is taken to the Blue Sky Plan official webpage after clicking on the “Add Parts to Cart” button. 
The original values of the quantity of parts can be restored by clicking on “Clear user Adjustments”. 
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25.10 Screenshots panel 
 
The Screenshot panel can be used for taking a screenshot with the button  l located in the top right 
corner of the workspace. After clicking the button, the “Save screenshot” message appears, and the 
screenshot is included in the column in the right panel. 

 

The arrows on the right are used for changing the screenshot size. 
Video allows the screenshots to be exported as an AVI video or animated gif with custom text and 
selected font size and type. 

 

 

25.11 CAM Export 
 
In addition to the normal export of models, the software allows you to create a CAM export. 
In order to export, you need to create at least one crown or one bridge. Once you complete this step, 
you can choose which models you want to export in the CAM column (1) inside of the export dialog. 
If the model is not CAM exportable the value will be “N/A” (2), otherwise there will be a checkbox for 
selection (3). 
If you want to see only models which can be CAM exported, you can use the button on the bottom left 
called “Show only teeth with CAM file support”. 
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The final product of the CAM export is a file called < name > .constructionInfo where all the 
information about the model are stored. 
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25.12 Crown and Bridge Preferences 
 

In “Preferences > Crown and Bridge” the user can set the Crown thickness, Crown cement spacer and 
Abutment cement spacer for different types of restoration available in the Restoration Design panel. 
CAD tools are available for the Denture module. The “Default tool size” is used for selecting the default 
tool size, and “Default tool strength” defines the default strength of the tool. “Teeth chain spacing” 
allows the user to set the spacing between the teeth in the teeth chain. 
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26 Splint Module 
 
Dental splints are the most common dental treatment for temporomandibular disorders (TMDs - 
tension in your jaw muscles, such as from clenching your jaw or grinding your teeth). These splints are 
used for short periods of time. They do not cause permanent changes in the teeth or jaw. They include 
bite plates and mouth guards that fit between and over the upper and lower teeth. 
Dental splints can help ease muscle tension and stabilize the jaw. They do this by preventing grinding 
and clenching of the jaw (bruxism) that might be causing muscle tension and pain. It is an important 
treatment that may last for 3 months or more. The splints are also used for muscle syndromes, a new 
VDO muscle test, mandibular lateral displacement and anterior repositioning. 

 
Blue Sky Plan makes it possible to plan splint treatments based on imported STL models of the jaw 
with teeth. The planning begins with an intro screen titled Splint, where the user selects the type of 
planning – Incisal Splint (AMPSA) or Occlusal Bite Splint. 

 
 

 
 
 
The specific type of planning can’t be changed in an upcoming process. 

 
The individual types of planning include: 

• Incical Splint (AMPSA) -> Align to Grid - Buccal Bite Registration - Jaw Articulation - 
Remove Undercuts - Add Anterior Deprogrammers - Draw Splint Curve - Set Raised Areas 
- Edit Splint Module - Export 

• Occlusal Bite Splint (Michigan-style splint) -> Align to Grid - Buccal Bite Registration - 
Jaw Articulation - Remove Undercuts - Draw Splint Curve - Set Raised Areas - Edit Splint 
Model - Export 
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26.1 Loading the Input STL Model 
 

 
The planning starts by selecting the Project Type (1). The next step is Patient Info. The user is asked 
to fill-in the patient’s name, the physician’s name and the treatment’s name (2). These steps are 
mandatory. The Treatment Description is used for the physician’s notes. Is it mandatory to select jaw 
(3)(mandible or maxilla) in the Annotation section. Workflow Settings (4) allows the user to set splint 
minimal thickness, splint offset from the jaw, open height for articulator, smoothness level and quality. 
To start the Splint wizard, click on the Next (5) button. 

 
26.2 Align to Grid 

 
The imported models might not be properly aligned (the alignment does not match the head in the 
bottom left of the 3D view). This makes planning very difficult. For these cases, Blue Sky Plan has an 
Align to Grid dialog, which opens after the Surfaces step in the Splint module. For alignment, it is 
necessary to select the primary model through which the alignment is to be done. 
To align the model to the grid, press the SHIFT key or use the dropper (1) button and add 3 points on 
the model by left clicking the mouse. Last point added can be removed by clicking on the undo button 
(2). The user can remove all points by clicking on the x button (3). 
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After alignment, the user can check the primary model using the grid. 
The grid can be disabled/enabled by clicking on the Show Grid (4) 
button. The model can be swapped by clicking on the Swap Orientation 
button (5). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

26.3 Buccal Bite Registration 
 

 
Blue Sky Plan allows for upper-lower jaw alignment using a “buccal bite” surface scan. This process 
requires both jaw models to be imported. The maxilla and the mandible are already automatically 
uploaded to the panel and it is only necessary to add one or more buccal bite scans (2) as well as 
to select the buccal bite name (1) by clicking on the dropdown menu. The software then 
automatically aligns the maxilla and the mandible by clicking on Add Buccal Bite STL Scan (3). 
Additional buccal bite alignments can be created (according to the number of the buccal bite scans) 
and visualization is possible for the mandible moving from the normal to each of the additional buccal 
bite alignments. 
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Positions Table displays a list of the jaw positions that were aligned with the buccal bite models. Bite 
Name displays aligned buccal bites. Buccal bites can be deleted by clicking on the x button. 
Move Mandible to Position - Instantly moves the mandible to the position chosen from the table. 
Animate Mandible to Position: Animates the mandible from the actual position to the position chosen 
from the table. 
Save Current Alignment of Mandible: Sets the actual position as a starting position for the position 
chosen from the table. 
Use Computed Alignment of Mandible: Sets the actual position for the position chosen in the table 
as calculated using the buccal bites models. 
Animation Speed slider: Sets the speed of animation. 

 
 

26.4 Jaw Articulation 
 
The lower jaw articulation can be visualised by adding jaw articulator. This function is not dependent 
on an import of the buccal bite. Collisions between the upper and the lower jaw can be shown in all 
positions. 

 
Place Jaw Articulator on mandible by left clicking on the occlusal edge between the mandibular central 
incisors to place the jaw articulator. 

 
 

 
Tip: Always make sure to place the articulator and that a non zero opening is set in order to 
make a space for the splint or anterior deprogrammer. 
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The articulator can be disabled/enabled by clicking on Show Articulator (1). Parameters can be 
edited by clicking on the Edit articulation parameters dropdown (2). 

 
26.5 Remove Undercuts 

 
Remove Undercuts this function is used to define the direction from which the splint will be inserted. 
Using this function, you can visualize the areas that run “under” the model (undercuts) and may cause 
problems when inserting the splint onto the teeth, especially in the case of using stiff materials for 
fabrication. The surgical guide fabricated on this model will be easy to mount. 

 

 

How to work with insert direction: 
 

◦ Select the model to work with 
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◦ Click on Define Insertion Direction to enable other functionalities 
◦ The insert direction should be adjusted using the rotation ring so that the 

undercuts are minimized 
◦ The insert direction can be defined by clicking on Define Insertion Direction 

from View 
◦ Reset insert direction will restore the original status of the arrow 

 
 

 
 
 

26.6 Add Anterior Deprogrammers 
 
The Anterior Deprogrammer is a flat plane occlusal splint with an anterior acrylic block designed to 
disclude the posterior teeth. Since the body has a protective reflex to prevent added pressure to the 
anterior teeth, when this splint is worn, less pressure is exerted. Blue Sky Plan anterior 
deprogrammers are represented by STL shapes that the user can manipulate. 

 
 



BS-LS-0161-en Rev 4 Blue Sky Plan® 158 2023-08  

To add a deprogrammer, click on the Add Anterior Deprogrammer button. The user is able to choose 
the anterior deprogrammer shape from an existing list and adjust its location and manipulate its 
measurements. Remove Anterior Deprogrammer the button removes the anterior deprogrammer. 

 
 

 
 
To create a new preset that allows you to save the current parameters of the deprogrammer, click on 
the Save button. A new dialog window appears with the Enter preset name option. Save your preset 
and see it in your presets 

 
 

 
 
To show more options, click on the ... option. Here you can delete your presets as well as export/ 
import presets. 
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26.7 Draw Splint Curve 
 
It is possible to fabricate splint guides in the program on the basis of imported STL models. It is also 
possible to edit the splint curve. 

 
 

 
 
To draw a curve on the model, click on Draw Curve and draw a curve by holding SHIFT and the left 
mouse button. The curve can be edited by dragging points. To remove the curve, click on the Clear 
curve button. 
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26.8 Set Raised Areas 
 
 

The raise to antagonist cusp tips 
method aims to extend the region 
bounded by the curve to the antagonist 
jaw. 
The Follow cusp tips radius determines 
the virtual inflation of antagonist cusp 
tips, that will be used for the resulting 
splint shape fabrication. A higher value 
will result in a flatter occlusal part of the 
splint, while lower values will result in a 
sharper indentation in the occlusal part of 
the splint. This value can be set by 
clicking on the slider. 
Raise to Plane raises the region 
bounded by the curve to the visualized 
plane. 
Offset by Minimal Thickness this 
method inflates the region bounded by 

the curve by the minimal thickness value. The offset and minimal thickness of the splint can be set by 
the sliders in the General Splint Settings section. 

 
The offset and minimal thickness of the splint can be set by the sliders in the General Splint 
Settings section. 

 
 

To create a splint preview, choose the preferred Raise Area Method (1). A splint preview will be 
created by clicking on the Generate Splint Preview (2) button. 
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26.9 Edit Splint Model 
 
 

 

26.10 Export 

Blue Sky Plan software allows the user to 
edit the model. Click on the dropdown 
menu (1) to select the model to edit. All 
the necessary tools are available in the 
Brush Tools section (2). The “Add/ 
Remove Brush” is used for adding/ 
removing the surface material. The 
“Local Deform Brush” deforms the 
surface at a local point. The “Smoothing 
Brush” can be used for final modifications 
and polishing the surface. Collisions (3) 
between the upper and the lower jaw can 
be shown in all positions. The user is 
able to work with Buccal bites by clicking 
on the Buccal Bite Positioning 
dropdown. 

The final step, Export, is common for all types of planning. The only difference is in what can be 
exported in this final step, OBJ or STL models (2). The quality of the export can be set in 
the Loading the Input STL Model (beggining of the Splint Wizard), which influences the quality of the 
resulting model but also the time necessary to generate the export. Export separated files (3) exports 
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selected objects to a separated file or one single file created by the user. The user can choose which 
model will be exported (1) and after selecting, the models will be exported by clicking on the Export 
button (4). 

 
 

 
 

26.11 Keyboard Shortcuts 
 
The user is able to select between 2 views - perspective and orthographic. To select between those 2 
views, click on the head orientation widget on num 5. It is possible to use keyboard shortcuts 1, 3 and 
7 or Alt 1, 3 and 7 to switch between views. 
Keyboard shortcuts 4, 6, 2 and 8 moves the camera 15°. 

 
26.12 Manipulation Shortcuts 

 
Shortcuts allow the user to manipulate the visible models in the 3D view. 
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R + Left mouse buttonrotates the model, T + Left mouse buttonmoves the model and Hhides the 
dragger. 

 
 

It is possible to orient the model from different perspectives using the orientation widget 
 

 
 

26.13 Visibility Panel 
 
Visibility panel allows the user to work with 3D objects to set: 

• visibility 
• opacity 
• renaming  
• deleting 
• changing the color 
• collisions  

 
To rename a model, click on the Rename button (1), write a new name (2) and click on the check or X 
button to confirm. 
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To change the model’s color, select the color of the model (1) and choose any color from the "Basic 
colors" set (2) then click on the OK button (3). 
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26.14 Editing Mode 
 
 
 

 

26.15 Surfaces 

The user is able to jump from Wizard to 
Editing Mode by right clicking the mouse -> 
Editing Mode. Then choose one of the 
supported editing functions from the toolbar 
on the right. The editing mode can be 
activated by clicking on the icon  in 
the upper right side bar. 
To leave the mode, click on the Leave Editing 
Mode button. 
Editing Mode allows the user to work with 
Surfaces and Edit Model panels. 

 
 

 

 
26.16 Edit Model 

 
See section Edit Splint Model 

Surfaces lists the imported patient STL 
models. 
The table includes the following 
attributes: 
Name - surface name 
Color - surface color 

 - surface visibility or hiding 
 - surface removal 
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26.17 Notes and Measurements 
 

Orthogonal slices and the normal slice can be positioned in the location of an overlay by double- 
clicking on the "Note Type" field (1) or "View" field (2) of the associated item. 

 
 
26.18 Create a screenshot 

 
The Screenshot panel can be used for taking a screenshot with the button located in the top right 
corner of the toolbar. After clicking the button, the screenshot is included in the column in the 
Screenshots panel. 
To delete a screenshot, select any screenshot and click on the Delete button. 

 
 

26.19 Toggle Grid 
 
Enables/disables the grid. 
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27 Preferences 
 
Blue Sky Plan® makes it possible to save user settings for the program and its environment. You mark 
the settings selection with the "Tools > Preferences..." menu option. 

 

 
 
 
27.1 General 

 
• Big icons – sets the size of the icons in the tool bars 
• Hide window titles – sets the visibility of the titles of windows with visualization data 
• Show implant to axial slice angle – displays the value of the implant to axial slice angle 
• Synchronize cross-sections zoom – if this option is turned on, moving and changing the ruler in 

any cross-section of the slice also changes the ruler in the other cross-sections of the slice 
• Always show selected implant/tooth – ensures visibility of the active implant when implants/teeth 

are fully transparent 
• Move slices to selected implant's position – clicking on the implant sets the positions of the 

orthogonal and normal slices on the selected implants 
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• Maximum intensity projection slice mode – this button for switching the slice display mode offers 
two variants: MIP (maximum intensity projection) and X-ray. 

• Start panoramic view in RTG mode – in panoramic window, opened data are viewed in RTG 
(=composite) mode 

• Force tabbed docking – disables the option to cascade panels above each other 
• Start model alignment dialog on model import – the process of model alignment will 

automatically perform, when the model is imported 
• Use point based model alignment in Wizard – manual adjustment using matching points and 

volume in Wizard 
• Implant always vertical in tangential view – any rotation of the implant displays implant vertically 

in tangential window 
• Swap face orientation in exported models – the exported models have swapped face orientation 

of the mesh 
• Advanced gestures in Leap viewing mode – enables advanced scene manipulation gestures in 

Leap viewing mode. A Leap controller is required. 
• Zoom with circle gestures – toggle the effect of the circle gesture between slider control and 

zoom control. 
 

27.2 Customization 
 

• Dragger delay – the time until the dragger disappears after the mouse cursor moves away from 
the implant or tooth 

• Model Import Quality – sets the quality of imported model 
• Export File Format – enables to choose the default export file format 
• Model Collisions Mode – enables to switch between different views of model collisions 
• Video Image Delay – when exporting steps plan within Ortodontics module, it is time interval 

between individual images of the exported video 
• Grid 3D (color, size, spacing, thickness) – the properties of 3D grid in the scene 
• Axis – the thickness of implant/scanbody axis 

 

27.3 Project 
 

• Autosave project – automatically saves the project at the time interval entered 
 

27.4 Shortcuts 
 
In these sections are defined shortcuts for many different actions. 

• Users can add or change the shortcut by clicking into the window "Keyboard Shortcut" and 
pushing the keyboard or combinations of keyboards. To confirm the newly defined shortcut it is 
necessary to click the button "Set". 

 

27.5 Advanced 
 

• Logging – allows information about the execution of the program to be stored in a log. The log 
can be displayed by clicking the "Show Log" button, and its content can make it easier for the 
program manufacturer to solve problems that arise when running the program on specific 
hardware configurations. 
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• Log OpenGL errors – enables to log OpenGL errors 
• Web Engine Settings – enables to choose how much the default web browser uses GPU 

acceleration 
• Module for shell open – enables to choose the default module used to open the data on double 

click in shell 
• Automatically check for updates – every day when it first starts up, the application checks 

whether you are using the newest release and, if not, offers to install the update for you. 
• Show Blue Sky Bio hints and messages – displays the bar containing hints and messages 
• Open videos in external browser – allows to open tutorial videos in external browser 
• Use system proxy – enables to use proxy servers set in the system 
• Antialiasing – enables the edge smoothing of the models 
• Enable LabPronto service – displays the LabPronto service 
• Show warning when recommended Software Guide Tube settings changed – displays the 

warning message if the parameters of Software Guide Tube are changed 
• Show warning for collisions between Software Guide Tubes and model – displays the warning 

message if Software Guide Tube collides with the model 
• Run nerve detection in Surgical Guide automatically – the automatic nerve detection is done for 

both foramens in Wizard 
 

27.6 Surgical Guide 
 
In this section, the different parts of surgical guide can be adjusted. 

• Software Guide Tube – Distance (ie. distance from implant abutment) and Wall Thickness 
• Surgical Guide – Offset (ie. distance between model and surgical guide) 
• Windows in Surgical Guide – Width, Height and Depth 
• Metal Cylinders – Lip Height and Lip Width (for custom Metal Cylinders) 
• GRS Guide (available in "File > Export to > GRS Guide") – Holes Diameter 
• Generated Model – enables to adjust Base Height, in case of using the function Close or Hollow 

Model 
• Articulation Pin Arms – Width and Height (see chapter 19) 
• Implant to tooth (occlusal side) – when aligning tooth to implant, Distance can be adjusted 
• Undercut – Insertion Path Direction and Maximum Allowed Undercut (see chapter 16) 
• Endo mode – see chapter 17 

 

27.7 BSB Direct Cut Drills 
 
These settings apply for BSB Direct Cut Surgical Guide Solution only. 

 

27.8 Orthodontics and Tooth Movement Limits 
 
See chapter 22. 

 

27.9 Crown and Bridge 
 
See chapter 24. 



BS-LS-0161-en Rev 4 Blue Sky Plan® 170 2023-08  

28 Automatic updates 
 
Blue Sky Plan® supports the option of automatically checking the availability of a newer version of the 
program. It does this once a day when it first starts up; this can be turned off in the program settings 
dialog in the “Advanced” tab with Automatically check for updates. This feature can be invoked 
manually with the menu selection “Help > Check For Updates…” 

 
 

 
 
If a new version is available, the program offers the user the options of postponing the update till later, 
downloading and installing the update immediately, or skipping this update completely. The update 
download runs directly in the application environment, and to install it, Blue Sky Plan® must shut down 
and then start the installation, so please close open projects before checking for a new version and 
installing the update. 
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29 Footnotes 
 
29.1 Blue Ski Bio Aligners Prescribed Instruction For Use 

 
Caution: US federal law restricts this product for sale by or on the order of a dentist or physician. 

 
Indication for Use 
Blue Sky Bio Aligners are a series of clear, lightweight, plastic appliances indicated for the treatment of 
tooth malocclusions in patients with permanent dentition (i.e., all second molars). Utilising a series of 
incremental tooth movements, it sequentially positions the teeth by way of continuous gentle force. 

 
Device Description 

 
Blue Sky Bio Aligners are a series of clear plastic aligners that offer a solution for aesthetic orthodontic 
treatment by utilising a set of removable aligners to correct tooth malocclusions. A dental health 
professional (e.g. orthodontist or dentist), using a standard personal computer, prescribes the Blue 
Sky Bio Aligners based on an assessment of the patient’s teeth, determines the course of treatment 
with the system, takes moulds of the patient’s teeth and then imports a digital version of the mould (or 
model) into the ordering software, then in the ordering software aligns the teeth as they want them at 
different phases of treatment. The phase models are exported from the ordering software and sent to 
Blue Sky Bio. Blue Sky Bio then prints a series of plastic trays intended to gradually realign the 
patient’s teeth in accordance with the physician’s prescription in the ordering software. The prescribing 
physician creates the models used to print the aligners. Blue Sky Bio produces trays which are formed 
of clear, thermoformed plastic. The trays are sent back to the dental health professional who then 
provides them to the patient, confirming their fit and design. Over a period of time, additional trays are 
provided sequentially to the patient by the dental health professional to gradually move the target teeth 
to the designed position. The dental health professional monitors the treatment from the moment the 
first aligner is delivered to when the final aligner is delivered. The trays are held in place by pressure 
and can be removed by the patient at any time. 

 
Storage and Handling 
Store the devices in a dry, clean and dust-free environment in the original packaging at modest 
temperatures (5°C to 40°C / 41°F to 104°F). 

 
Contents of the Box 
The box contains the aligners for the patient identified by the stickers on the plastic bags containing 
the aligners. These were made from the models you sent to Blue Sky Bio. If at any office visit the 
aligner fits incorrectly, scan the patient, go through the construction/ordering process again and send 
Blue Sky Bio a new model for aligner re‐fabrication. 
The aligners are delivered clean but NON‐STERILE in a plastic bag. The plastic bag has a sticker on it 
which identifies the patient and which number of aligner is in the bag. The patient should be instructed 
to clean the aligner with toothpaste and a toothbrush each day. The teeth should be brushed before 
inserting the aligner. 
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29.2 Computerised Orthodontic Bracket System 
Instructions for Use 

 
Caution: US federal law restricts this product for sale by or on the order of a dentist or physician. 

 
Indication for Use 
The Blue Sky Bio Computerised Orthodontic Bracket System is a software system intended for use as 
an aid in orthodontic treatment planning to correct malocclusions in orthodontic patients. For use by 
dental professionals trained in orthodontic treatment, including radiographic analyses and treatment 
planning. The Blue Sky Bio Computerised Orthodontic Bracket System is intended for use with 
commercially available brackets currently used in standard orthodontic treatment. The end product is 
an indirect bonding tray for use by the dental professional to place multiple brackets at the same time. 
The additive printing of the indirect bonding trays should only occur at a validated printing centre. Each 
validated printing centre is to be a registered and listed contract manufacturer with Blue Sky Bio, as 
documented to the FDA per the Device Establishment Registration and Listing (see CFR Part 807). 

 
Device Description 
The device consists of proprietary software that allows the placement of virtual orthodontic brackets on 
3D models supplied by the clinician. The physical models are scanned and converted into virtual 
models in the software. An indirect bonding tray made out of resin is produced. The physical 
orthodontic brackets are inserted into the indirect bonding tray. The tray aids in the accurate bonding 
of the brackets, duplicating the position of the virtual brackets in the planning software. The tray is 
produced using two alternative methods. 
One method utilises the virtual model of the patient model with virtual brackets. The indirect bonding 
tray is designed and printed as a negative of the virtual model with the brackets in place. The printing 
of the indirect bonding tray should only occur in an FDA registered establishment. 
The second method utilises a printed patient model with markers indicating the position of the 
brackets. The brackets are glued to the model on the marked areas and the indirect bonding tray is 
pressure thermoformed over the model capturing the brackets. 
Both methods result in a resin indirect bonding tray with brackets attached to the tray according to the 
bracket position planned in the software. The clinician inserts the tray with the brackets on the patient’s 
dentition, allowing the accurate positioning and bonding of the brackets. Commercially available 
brackets are used as part of the system but are not part of the submission. 
The software is available for download on the Blue Sky Bio website and it is used by Blue Sky Bio and 
authorised users. The download includes the instruction manual, which can also be downloaded 
separately on the Blue Sky Bio website. The software requires activation for authorised users. 

 
 

29.2.1 User Identification 
 
The clinician creates the patient models to be scanned into the software. The clinician either creates or 
reviews and approves the virtual orthodontic treatment plan, including the bracket positions. The 
software is intended to be used by Blue Sky Bio and authorised entities manufacturing the indirect 
bonding tray based on the clinician-approved positioning of the brackets. 

 
How to use the Computerised Orthodontic Bracket System 
The dental professional creates a model of the patient’s dentition. The model is scanned and 
converted into digital model using any legally marketed scanner for dental applications which will 
export STL files. Scanning a physical impression to make a virtual patient model is also possible. The 
model data is imported into an activated copy of the Computerised Orthodontic Bracket System on a 
standard personal computer with the following specifications: 
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• OS: Windows 10 Home/Professional 64 bit 
• Processor: Quad Core Intel i7 or comparable 
• RAM: At least 16 GB 
• Video card: dedicated NVidia or AMD card, at least 3 GB video RAM, (e.g. NVidia GeForce 

GTX 650, AMD Radeon HD 7750, ...) 
• Monitor: 21 inches, resolution at least 1920 X 1080 
• Hard Disk: 5 GB of free space 

An authorised user is required to activate the software. The authorised user is either a Blue Sky Bio 
employee or an authorised purchaser. Authorised users follow the specification requirements 
guidelines determined by Blue Sky Bio for using their computer and printer with the Computerised 
Orthodontic Bracket System. 
The software has a database of 3D models of commercially available orthodontic brackets. Based on 
the patient’s 3D models and treatment plan the software operator identifies the ideal placement of the 
brackets. The bracket placement is reviewed and approved by the dental professional. The dental 
professional can adjust the final position of the bracket if desired. 

 
Manufacturing of the Indirect Bonding Tray (IBT) 
Two alternative methods are used to manufacture the indirect bonding trays. 
1. The virtual model of the patient’s dentition with the virtual brackets in place is utilised to create a 
negative of the model. This virtual model fits on top of the dentition of the patient and has also cavities 
matching the shape of the brackets. The user defines the outline of the indirect bonding tray in the 
software and a virtual model of the tray is created. This model is printed using a new and not recycled 
legally marketed material for short term use in the mouth called NextDent Ortho IBT utilising a 3D 
printer satisfying the specifications of Blue Sky Bio described in section 16.11.4. The tray is delivered 
to the clinician. 
2. In an alternative method, a model of the patient’s dentition with bracket positioning markers is 
printed utilising a 3D printer satisfying the specifications of Blue Sky Bio described in section 16.11.1. 
The actual brackets are temporarily attached on the markers of the model. A legally marketed 
thermoplastic resin sheet such as Dentsply Essix Ace is pressure formed on top of the model 
capturing the patient’s dentition and brackets. Any standard thermal pressure forming machine can be 
used following the guidelines of the manufacturer of the resin sheets. A pressure forming machine is 
sold by the manufacturer of Essix Ace. The sheet is trimmed to the middle of the brackets. Excessive 
undercuts are removed and the tray is made suitable to be used as an indirect bonding tray and 
delivered to the clinician. 

 
Use of the Indirect Bonding Tray (IBT) 
IBT’s are patient-specific devices intended for short term use in the patient’s mouth. The indirect 
bonding tray is a placement guide to allow a dentist to place orthodontic brackets in a precise manner. 
Manufacturing the tray using the two alternative methods does not change the way it is used. The key 
to the tray’s clinical use is the fit on the patient’s dentition and the location of the spaces holding the 
brackets during the bonding process. The clinician verifies the accurate fit of the tray on the dentition. 
In addition, the position of the brackets in the patient’s mouth is verified to ensure that the location of 
spaces for the brackets matches the virtual treatment plan. Once the shape of the tray has been 
verified, the clinician inserts the brackets into the tray and places a legally marketed bonding agent. 
The final step is placing the tray back in the patient’s mouth to bond the brackets onto the patient’s 
dentition following the instructions of the manufacturer of the bonding agent. If necessary, the clinician 
can adjust the bracket position removing one or more brackets and using traditional manual bracket 
placement. The procedure is the same for a printed or thermoformed indirect bonding tray. 
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29.3 Blue Sky Bio Aligner G - Patient Instruction 
 
Rx only 
Federal law restricts this device to sale by or on the order of a physician. 

 
Device Description 

 
Blue Sky Bio Aligner G is a sequence of clear plastic removable orthodontic aligners that gradually 
move the patient’s permanent teeth in small increments to correct a misalignment. 
Indications for Use 
Blue Sky Bio Aligner G is a series of clear, lightweight, plastic appliances indicated for the treatment of 
tooth malocclusions in patients with permanent dentition (i.e. all second molars). Utilizing a series of 
incremental tooth movements, it sequentially positions teeth by way of continuous gentle force. 

 
Contraindications 

 
▪ Do not use if you are allergic to plastics. 

 
Warnings and Precautions 
1. Because the aligners are worn in the mouth, accidental swallowing or aspiration of the appliance 
may occur and may be harmful. 
2. Keep aligners away from hot water and harsh chemical solutions. 
a) Do not use denture cleaners to clean aligners. 
b) Do not drink hot or colored liquids with aligners in place – they may become distorted or discolored. 
3. Keep aligners out of reach of young children and pets. 
4. When not in use, store aligners in provided container. 
5. Aligners worn out of sequence can result in delayed treatment and complications including patient 
discomfort. Always follow the order and wear of aligners specified by doctor. 
6. Sensitivity and tenderness to teeth may occur during treatment, especially when moving forward 
from one aligner step to the next. 
7. Aligner wear may temporarily affect speech. Patients typically adapt quickly to the aligners within a 
week or two. 
8. Irritation of the soft tissue in the mouth (gums, cheeks, tongue and lips) may occur. Consult your 
doctor if this persists. 
9. Avoid chewing gum when using the aligners. 
10. Do not use sharp objects to remove aligners 
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Directions for Use 

Hygiene 

1. Rinse new aligners with cold water prior to first use. 
2. Prior to each use, aligners should be cleaned. Use a soft bristled toothbrush and a small amount of 
toothpaste. Do not expose aligners to hot water. 
3. Wash hands thoroughly with soap and water before handling aligners. 
4. Take care to maintain proper oral hygiene during aligner use and treatment. 
a) Brush and floss after each meal, prior to inserting aligners. 
b) Maintain regular dental checkups and cleaning appointments during the aligner treatment period. 

 
Aligner Placement 

 
1. Aligners are to be worn according to doctor’s instructions, usually for 20-22 hours per day, for the 
doctor recommended number of days for each aligner in sequence. 
2. Handle only one aligner at a time. 
3. Make sure to insert the aligners as marked – for upper or lower use. Either upper or lower may be 
inserted first. 
4. When inserting the aligner, gently push over the front teeth, then apply pressure, using your 
fingertips, to the tops of the left and right molars (back teeth) until the aligner snaps into place. 

 
Aligner Removal 

 
1. When removing the aligners, on one side of your mouth, use your fingertip on the inside of the back 

molar to slowly pull the aligner from the molars. Repeat the process on the others side before trying to 
completely remove the aligner. Once it is disengaged from the molars, gentle prying away from the 
teeth with the fingertips should allow removal without damaging the aligner. 

2. After removal, rinse aligner with water, shaking off excess water, and store in the case provided. 

3. If you have attachments in place on your teeth during the aligner treatment, take care in removing 
aligners to not dislodge the attachments 

 
29.4 Blue Sky Bio Aligner G - User Instruction 

 
Indications for Use 

 
Blue Sky Bio Aligner G is a series of clear, lightweight, plastic appliances indicated for the treatment of 
tooth malocclusions in patients with permanent dentition (i.e. all second molars). Utilizing a series of 
incremental tooth movements, it sequentially positions teeth by way of continuous gentle force. 

 
Contraindications 

 
▪ Blue Sky Bio Aligner G is contraindicated for patients who are allergic to plastics. 

 
 
 
 



BS-LS-0161-en Rev 4 Blue Sky Plan® 177 2023-08  

 
Device Description 

 
Blue Sky Bio Aligner G is a series of clear plastic aligners that offer a solution for aesthetic orthodontic 
treatment by utilizing a set of removable aligners to correct tooth malocclusions. 
Blue Sky Bio Aligner G is 3D printed using Tera Harz Clear, P/N TC-85DAC, photo-curable resin, by 
Graphy Inc. 
The dental software used during the planning and manufacturing of the aligners is Blue Sky Plan 
software module for Blue Sky Bio Aligner G. 
A dental clinician (e.g. orthodontist or dentist), using a standard personal computer prescribes the Blue 
Sky Bio Aligner G based on an assessment of the patient’s teeth and determines the course of 
treatment with the system. The clinician takes molds of the patient’s teeth and completes a 
prescription form and sends the molds to the dental lab, which in turn scans the molds and uploads 
the .STL files of the molds in Blue Sky Plan software. This digital file is a series of CAD files (.STL) for 
building models that can be used to fabricate aligners. Alternatively, the dental clinician may generate 
the digital files by scanning the patient's mouth directly, using an intraoral scanner, and then sends the 
files to Blue Sky Bio or its authorized lab. 
The dental lab or the clinician designs a series of digital models and plastic trays intended to gradually 
realign the patient’s teeth, using Blue Sky Plan software. The prescribing physician reviews and 
approves the model scheme before the aligners are produced. Once approved by the clinician, Blue 
Sky Bio or its authorized dental lab produces the Blue Sky Bio Aligner G sequential aligners, which are 
formed of clear 3D printed Tera Harz Clear resin. The sequential aligners are 3D printed and cured in a 
post-curing unit. The fabricated Blue Sky Bio Aligner G series are then cleaned and polished to 
remove rough edges by the dental lab, as needed, prior to delivering the aligners to the dental 
clinician. 
Blue Sky Bio Aligner G are sent to the dental clinician who then provides them to the patient, 
confirming fit and design. Over a period of time, additional trays are provided sequentially to the 
patient by the clinician to gradually move the target teeth to the designed position. The dental health 
professional monitors treatment from the moment the first aligner is delivered to when the final aligner 
is delivered. The trays are held in place by pressure and can be removed by the patient at any time. 
Each aligner in the series is worn for approximately 1 to 2 weeks, for 20 to 22 hours per day, (however, 
they are to be removed for eating and for cleaning), after which they are replaced by the next stage 
aligners. This is repeated for the duration prescribed by the dental clinician. 

 
Required Equipment and Design Software 

 
The following material, equipment and software are required to produce Blue Sky Bio Aligner G: 
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Clinician’s Instructions for Blue Sky Bio Aligner G 

 
Scanning 

 
The first step is to obtain the dimensions and details of the patient’s baseline dentition. The clinician 
takes molds of the patient’s teeth and completes a prescription form and sends the molds to the dental 
lab, which in turn scans the molds and uploads the .STL files of the molds in Blue Sky Plan software. 
This digital file is a series of CAD files (.STL) for building models that can be used to fabricate aligners. 
Alternatively, the dental clinician may generate the digital files by scanning the patient's mouth directly, 
using an intraoral scanner. 

 
Design processing 

 
The second step is to create sequential digital aligners. The dentist then uses Blue Sky Plan Software 
module for Blue Sky Bio Aligner G to develop the treatment plan and to produce standard STL 3D files 
to facilitate the manufacturing of each sequential aligner in the treatment plan. Alternatively, a dental 
technician, develops the treatment plan and sends it to the treating licensed dentist for review and 
approval of the treatment plan prior to 3D printing. 
CAUTION – The dentist should only provide a few sets of aligners at a time to the patient. Dentist must 
monitor patient’s progress periodically prior to delivering subsequent aligners. 
➢ For detailed instructions on how to use the Blue Sky Plan software, please refer to User Manual – 
Blue Sky Plan Software – Blue Sky Bio Aligner G. 

 
Instructions for Printing & Post Processing of Blue Sky Bio Aligner G 

Blue Sky Bio Aligner G Printing process 

The third step is for fabricating aligners with a 3D printer. Use Blue Sky Plan Software for Blue Sky Bio 
Aligner G to plan the treatment by creating a series of sequential aligners that gradually position the teeth 
into their final desired position. Use 3D printer SprintRay Pro 95 to print the aligners for each treatment 
step. 
▪ This step requires digital aligners file: STL format files 
▪ STL File size: less than 500 MB of each file. 

 
Parametric Consideration for Printing Blue Sky Bio Aligner G on SprintRay Pro 95 

 
▪ Material Mode: SPRINTRAY SPLINT Layer 
▪ Resin Curing Wavelength: 405nm LED 
▪ Layer Thickness: 100μm 
▪ Exposure Time: 2 Seconds 
▪ Recommended orientation angle (degree): 30˚ from platform/print bed 

▪ Support function: Auto 
▪ Printing Position: All position Offset: 5mm 
▪ Environmental Conditions 

o Temperature: 15 ~ 25°C 
o Relative humidity: 30 – 75% 
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Features of Printer Software 
a) STL file import 
b) Automatic rotation and placement 
c) Layer slicer for path inspection 
d) Auto and manual generation of supports 

 
Material Reuse (uncured resin, leftover photopolymers) 

 
A. Validated and acceptance criteria for material reuse is up to 6 times or less. Discard any uncured 
resin (leftover resin) after 7 times use. 
B. Required volume of resin for fabricating aligners up to 7 times for SprintRay Pro95 = 310g. 
C. Required volume of resin for fabricating one set of aligner = 35g. o The one set of aligner refers to 
an upper (maxillary) aligner and a lower (mandibular) aligner. 
D. Minimum replenishment volume(amount) of resin for SPRINTRAY Pro 95: 100g. 
E. Note – Any uncured resin (leftover resin) in the resin tank is not allowed to be poured back to 
original resin bottle. Please discard uncured resin (leftover resin). 
F. Caution – Do not mix new resin and leftover resin (uncured resin). There is no relation between 
chemical, oxygen and moisture. Therefore, monitoring of the resin condition is not required. 
G. Note – Graphy Inc. only guarantees the quality of aligners that is continuously printed up to 6 times 
or less. 

 
Printing Preparation 

 
A. Shake the Tera Harz Clear well in its original packaging before use. 
B. If different types of resin or alcohol used during cleaning remain in a vat, it can weaken the material 
property of the printed aligner or lead to printing failure. After printing, always clean the resin tank to 
remove any impurity. 
C. Be sure to wear protective glasses and protective gloves when handling resins and printed parts. 
D. Open the 3D printer cover and make sure there is no impurity left on the plate or resin tank and 
pour the Tera Harz Clear into the resin tank of the printer up to the required filling line by manufacturer. 
Caution – When filling the resin into the resin tank, nitrile gloves, protective glasses and mask should 
be used.) 
E. Close the printer cover. 
➢ For detailed instructions on how to prepare the 3D printer, please refer to the OEM User Manual, 
SprintRay PRO 95 User Manual. 

3D Printing Process 

A. Load digital aligners file (STL) for starting. 
B. For printing the aligner model on the build platform, use the software tool of the printer to set the 
optimal position at 30 degrees from platform. 
C. Generate supports on the lingual using the recommended setting by printer provider. If the support 
is not enough, add supports on the aligner model. 
D. Start printing. 
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Cleaning Residual Resin on the Printed Aligner 

 
A. Detach the printed aligner model from the build platform. 
B. Remove supports from the aligner. 
C. Place the aligner on a paper towel and let the aligner stand for 1 hour until the residual resin is 
removed or cleaned from the aligner. (Face the inner surface of the aligner to the bottom to facilitate 
removal of the residual resin.) 
D. Check if there is any residual resin remaining inside the aligner. If residual resin still remains, wipe it 
off with a cotton swab. (Note – If there is residual resin that remains inside, it can cause incongruity.) 
➢ Caution – After the printing work is completed, the resin tank typically contains some leftover resin 
(uncured resin). This resin is not allowed to be reused. Discard the residual resin for new print work in 
safety. Do not mix the new resin with uncured resin (leftover resin). 

 
Post-processing 

 
The fourth step is post-processing. In this step, the aligner becomes fully hardened. CureM U102H UV 
Cure Oven is required for post UV curing and nitrogen process. 

 
Required post-processing equipment (a UV-light curing & Nitrogen units) 

 
- Brand Name: Cure M U102H 
- Curing Chamber: Required 
- Supply Voltage: 100-240, 50/60 
- Lamp Power: 80 W 
- Light Intensity: 400 mW/cm2 
- Lamp Wavelength: 395 ̴405nm 
- Curing Time (min): 60 minutes – Turn object between the curing time 

 
A. The printed aligner must undergo post UV curing and nitrogen process with CureM. Using any other 
post curing unit is not allowed. 
B. Place the aligner on the plate of the CureM. 
C. Connect the tube of nitrogen generator to the connector of the plate. 
D. Place the plate inside on the curing unit. 
E. After that, add nitrogen at 10 L/m for 1 minute. 
F. Start the first post-curing for 30 minutes, turn the aligner on the opposite side and cure for an 
additional 30 minutes under same condition, by filling chamber with Nitrogen first. 
G. Take out the aligner from the CureM using tongs after post-curing is done. 
H. Polish the aligner with a wet sandpaper by general dental method, if it is needed 
➢ For detailed instructions on how to use the CureM U102H, please refer to the OEM User Manual, 
CureM U102H User Manual.  
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Cleaning and Finishing 

After the post-curing process, clean the aligners and finish the fabricating process. 
A. Wash the aligner in warm water. 
B. Place the aligner on a tissue (paper towel) and let it stand for 30 Minutes until the remaining water 
is cleaned and dried. 
C. After the aligner is completely dried, check the surface of aligner and finish the process. 

 
Dental Lab Instructions for Labeling and Packaging of Blue Sky Bio Aligner G 

 
Prior to sending aligners to the clinician, place each aligner in a plastic bag, labeled with the following: 
o Patient Name and Identifier number 
o Doctor’s Name 
o Dental Lab address and contact information 
o Rx – Prescription Use Only Symbol 
o Aligner Step # 
o Consult Patient Instruction for Use – Blue Sky Bio Aligner G 

 
Notification 

 
The Tera Harz Clear specifications have been validated with the required equipment and the validated 
manufacturing process and software. Any other equipment and manufacturing process will be outside of 
the device specifications. 

 
Warnings 

 
▪ Tera Harz Clear contains polymerizable monomers which may cause skin irritation (allergic contact 
dermatitis) or other allergic reactions in susceptible persons. If contact with skin, wash thoroughly with 
soap and water. If skin sensitization occurs, discontinue use. If dermatitis or other symptoms persist, 
seek medical assistance. 
▪ Avoid inhalation or ingestion. High vapor concentration can cause headache, irritation of eyes or 
respiratory system. Direct contact with eyes may cause possible corneal damage. Long-term 
excessive exposure to the material may cause more serious health effects. Monitor air quality per 
OSHA standards. 
▪ Tera Harz Clear should not be used for any other purpose and it is only to be used for orthodontic 
appliances. Any deviation from this instruction for use may have negative effect on the chemical and 
physical quality of Tera Harz Clear. 
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Inhalation 

 
Tera Harz Clear is irritating to respiratory system. High atmospheric concentrations can cause irritation 
of the respiratory system, dizziness, headaches and anesthetic effects. 

 
Skin contact 

 
Tera Harz Clear may cause sensitization by skin contact. Irritation to skin, repeated or prolonged 
contact may cause dermatitis. 

 
Eye contact 

 
High vapor concentration of Tera Harz Clear may cause irritation. 

 
Ingestion 

 
Tera Harz Clear has low oral toxicity, but ingestion may cause irritation of the gastrointestinal tract. 

 
Protection 

 
Wear protection when handling Tera Harz Clear. Protective glasses and nitrile gloves are advised. 
▪ H317 May cause an allergic skin reaction. 
▪ H413 May cause long lasting harmful effect to aquatic life. 

 
Precautions 

 
▪ Read all safety and operating instructions beforehand. 
▪ Wear protective glasses and nitrile gloves whenever you handle the Tera Harz Clear resin. 
▪ Work in a ventilated area. 
▪ Cure any resin you plan to dispose of. 

 
Adverse Reactions 

 
Tera Harz Clear may cause allergic reactions. In case of an allergic reaction, please contact an 
orthodontist or dentist. 

 
Disposal 

 
▪ Fully cure any liquid resin you plan to dispose of. 
▪ The product Tera Harz Clear in its polymerized form is not environmentally harmful. Residual waste 
material in its liquid state should be delivered to a collection point for waste material. 
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Storage Conditions, Expiry Date and Transport 

 
Store the Tera Harz Clear product in its original packaging at room temperature in a dry and dark area, 
preferably in 15~25°C. Close the packaging after each use. 
The expiry date of Tera Harz Clear is on the product label. Do not use Tera Harz Clear past its expiry 
date. 

 
Explanation of Symbols 

 

 
 
Blue Sky Bio, LLC 
800 Liberty Drive, Libertyville, IL 60048 
info@blueskybio.com 
(888) 446-6724 
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